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l-u EDITORIAL

E— This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FuLL CIRCLE! / '_O'o
o

i

creati
commons
A new addition to Full Circle is the Software Showdown. Each month, Tushar will

have similar applications compete against each other to see who will come out on top. .
This month: PDF viewers. Full Circle Podcast

he usual LibreOffice, Blender, and Inkscape HowTo's are here, but Greg has had to

take this month off. Replacing your regular Python article is an interesting piece on
automating Gpodder to become your personal entertainment assistant. Give that a try.
And, while you're at it, you can try hooking up to the Internet using IPV6 in this month's
other HowTo.

LibreOffice

The Document Foundation

Released monthly, each episode

. . covers all the latest Ubuntu news,
Ubuntu Women has the story of a school which completely switched to Ubuntu and i e

if you enjoyed last month's Linux Lab article about DVD video, then this month's article listener feedback. The Side-Pod is
should tickle your fancy too. This time Charles discusses creating DVD menus. a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch

Gord has tweaked his Q&A column to include links to the most popular questions 2 T 5 e 25

from AskUbuntu.com. This is something quite a lot of you asked for in the survey. somewhere to put all the general
technology and non-Ubuntu stuff
Now is the best time to submit a shot of your desktop for the My Desktop section as t':)adtc‘:‘s’tesn tfitin the main
| am now officially out of screens. If you fancy submitting your desktop for others to 2 ’
see, please read the info on the penultimate page of this issue. Hosts:
E E  Les Pounder N "
« Tony Hughes o ..IJ '.
All the best, and keep in touch! 1 é)olR/ g’ggrbkerla'” —\_Z
Ronnie
ronnie@fullcirclemagazine.org http://fullcirclemagazine.or
E [ rucio vr: |MEY Aunio oss |
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MARK SHUTTLEWORTH
cLOSES UBUNTU BUG #1

M ark Shuttleworth closes
Ubuntu bug #1 with
following words: “Personal
computing today is a broader
proposition than it was in 2004:
phones, tablets, wearables and
other devices are all part of the mix
for our digital lives. From a
competitive perspective, that
broader market has healthy
competition, with 10S and Android
representing a meaningful
share...Even though we have only
played a small part in that shift, |
think it’s important for us to
recognize that the shift has taken
place. So from Ubuntu’s perspective,
this bug is now closed."

Full remarks at:

http://fridge.ubuntu.com/2013/05/ :

UBUNTU NEWS

Written by The Ubuntu News Team

realities - :
: http://www.iloveubuntu.net/mark- :

: microsofts-hold-computing-

declining/

. shuttleworth-closes-2004s-bug-1-
: due-todays-realities

: Mark Shuttleworth Marks Bug #1,
: ‘Microsoft Has Majority
. Marketshare, As Fixed -
: http://www.omgubuntu.co.uk/201

. 3/05/mark-shuttleworth-marks-
: bug-1-fixed

. Ubuntu declares bug #1 -

: 'Microsoft has a majority market
. share' -- closed -

: http://www.zdnet.com/ubuntu-
: declares-bug-1-microsoft-has-a-

. COMMUNITY ON

Ubuntu bug #1 marked as fixed by UBUNTU.COM

. Mark Shuttleworth - :
: http://www.webupd8.0rg/2013/05 :
: [ubuntu-bug-1-marked-as-fixed-by- :
: mark.html

aniel Holbach announces the
launch of

: http://community.ubuntu.com,
. which “is the primary address for
© interested Ubuntu users to stay

. involved and get informed about
: what our community is doing."

© http://fridge.ubuntu.com/2013/05/
: 31/community-on-ubuntu-com/

majority-market-share-closed-

31/mark-shuttleworth-closes-
ubuntu-bug-1/

Want more on the closure of bug
#1? Several news sites blogs
covered it, here's a sampling of
what they had to say:

Mark Shuttleworth closes the
2004's bug #1 due to today's

: 7000016129/

closes-ubuntus-bug-no-1-

. MARK SHUTTLEWORTH:

Mark Shuttleworth closes Ubuntu’s HERE COMES THE CARRIER

: Bug No. 1 now that Microsoft's
. hold on computing is declining - :
. http://blogs.dailynews.com/click/2 :
 013/05/30/mark-shuttleworth-

. ADVISORY GROUP

Full circle magazine #74 @ 4

: Ubuntu Carrier Advisory Group has
: taken place to help “figure out how
: . best to shape Ubuntu to meet the

: Ubuntu Marks 'Bug No. 1" As Fixed, :
. After Nearly Nine Years -
: http://www.npr.org/blogs/thetwo- :
: way/2013/05/30/187318344/ubunt :
: u-marks-bug-no-1-as-fixed-after-
: nearly-nine-years

needs of the mobile industry.” Of

: the meeting itself, Shuttleworth

also writes: “We mapped out our
approach to the key question I've

. been asked by every carrier we've
: met so far: how can we

: accommodate differentiation,

© without fragmenting the platform
: for developers? We described the

: range of diversity we think we can
: support initially, received some

© initial feedback from carriers

© participating immediately, and I'm
. looking forward to the distilled

. feedback we'll get on the topic in

: the next call”

: http://www.markshuttleworth.com
: /archives/1261

Canonical's announcement:

: “Formation of Carrier Advisory

: Group for Ubuntu mobile

. development” -

: http://www.canonical.com/content
: [Formation-carrier-advisory-group-
: ubuntu-mobile-development

: Finally, several news outlets and

: M ark Shuttleworth announces other blogs have covered this

that the first meeting of the news, here's a sampling selected

by our editors:
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UBUNTU NEWS

Ubuntu phone OS has eight
carriers signed on to boost
development -
http://arstechnica.com/informatio
n-technology/2013/06/ubuntu-
phone-os-has-eight-carriers-
signed-on-to-boost-development/

support-from-eight-mobile-

operators

: Canonical unveils Carrier Advisory
: Group for Ubuntu phones - :
: http://www.theregister.co.uk/2013 :
: /06/18/ubuntu carrier advisory b

Ubuntu Carrier Advisory Group
Announced -

6/18/ubuntu-carrier-advisory-
group-announced/

Canonical announces Ubuntu
Carrier Advisory Group with LG
UPlus, Telecom Italia, Korea
Telecom, Deutsche Telekom, etc,
as members

nical-announces-ubuntu-carrier-
advisory-group-lg-uplus-telecom-
italia-korea-telecom-deutsche

8 Major Mobile Carriers Join
Ubuntu Touch Advisory Group -
http://www.omgubuntu.co.uk/201
3/06/8-mobile-operators-give-
backing-to-ubuntu-touch

Canonical's Ubuntu for
smartphones gets support from
eight mobile operators -
http://www.theinquirer.net/inquir
er/news/2276104/canonicals-
ubuntu-for-smartphones-gets-

; oard/

. . UBUNTU DONATIONS AND
http://www.jonobacon.org/2013/0 :
. COMMUNITY FUNDING

pecific details about Ubuntu
Donations and Community

. Funding have been announced

. Following a plan prepared by Jono
. Bacon and approved by the

: Community Council. Donation
-http://www.iloveubuntu.net/cano : Periods will occur every 6 months,
. and the money received in the

. previous cycle will go to fund the
. current cycle. Those wishing to

- apply for funding must submit a

: Form, and it cannot be used for an
. arbitrary amount of money for a

. person or a team. A report

: containing the budget, a list of

. items where the money was spent,
. and the remaining balance will be
. released at the end of the cycle.

: http://fridge.ubuntu.com/2013/06/ :
: 20/ubuntu-donations-and-
: community-funding/

IMPROVING WEB SERVICES

. FOR UBUNTU

I n an effort to improve web

services and help address issues

: under the Ubuntu One name.

: Information from the various

: services will soon be available from
: the same place in order to relieve

: some confusion. Along with the re- :
. branding comes an improved

. design and a new user interface.

. http://fridge.ubuntu.com/2013/06/
: 21/improving-web-services-for-

ubuntu/

WELCOME NEW MEMBERS
. AND DEVELOPERS

At the Developer Membership

buntu-news-team/2013-

_ June/001815.html

Many Thanks to the Ubuntu News
: Team for their contribution this
: month.

: from user testing, various services
: like Ubuntu Single Sign On and
: Ubuntu Pay are being re-branded

News this month comes from:

https://wiki.ubuntu.com/UbuntuwW

. eeklyNewsletter/Issue319

https://wiki.ubuntu.com/UbuntuwW
: eeklyNewsletter/Issue320

¢ https://wiki.ubuntu.com/UbuntuwW

. eeklyNewsletter/Issue321

https://wiki.ubuntu.com/UbuntuwW
: eeklyNewsletter/Issue322

Board meeting on 2013-06-03 :

. the following individuals joined
. MOTU:

: Matt Fischer - :
: https://wiki.ubuntu.com/MattFisch :
. er | https://launchpad.net/~mfisch :

. Dmitry Shachnev - :
. https://wiki.ubuntu.com/DmitrySh :
. achnev :
' https://launchpad.net/~mitya57

https://lists.ubuntu.com/archives/u
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hen going through last

pleasantly surprised to see a

number of interesting suggestions,
: or 64-bit.

and what seemed to be an overall
positive response to C&C.
However, | also noticed a few
suggestions and requests for
topics | have already covered. As
such, | decided I'd devote this
article to directing those to the
past issues, and to also answer

were aimed in my direction.
LaTeX: | covered thisin C&Cin
FCM#50 and #52 — where 52 was

aimed more at Asian languages in
LaTeX.

having issues. | had a short-lived

virtualization series in FCM#38-45,
[swest34@gmail.com. Please put
: “conky question” in the subject,

but the short answer is, go to this
web page:

https://www.virtualbox.org/wiki/D :
- Isb_release -a and conky -v

ownloads

Install the current version of
VirtualBox for Linux hosts, then

COMMAND & CONQUER

Written by Lucas Westermann

the Extension Pack. You have to
month's survey results, | was : select the VirtualBox package

: which corresponds to the version

of Ubuntu you are using, and 32-bit

Automation: A surprising

. number of you seemed to be

© interested in writing bash scripts
: to automate things (either for

: yourself or for family members). |
: introduced that topic in C&C in
some of the quicker questions that : FCM#24, but judging by the

: response, I'll probably be writing
: another few articles on that at a
: later date.

Conky: There were a fair

amount of requests on getting
. started with conky. | have covered

Virtualbox: Someone asked for : Conky in the following issues of

advice on how to install Virtualbox : FCM (in the C&C column): #44,

in Ubuntu 12.04 because they were : #45,#46, #48, #51. If you have any

: particular issues with Conky, feel

free to email me about it at

and include the output of both

IDEs: Someone asked for a
review of IDEs — without knowing

exactly what languages you want
- to develop for, it would be a fairly
: confusing article. That being said, |

did discuss IDEs in FCM#64.

CLI Coloring: A couple of

people asked about styling your
: prompt and terminal. | have
discussed thisin FCM#27, #35, #36

Command-line “cookbook”:

© Someone asked for a collection of :
- useful command combinations and :
© | thought it might be interesting to
- open this up to the readers. Ifyou :
: have a favourite command (or ones :
: you simply find yourself using a

: lot), feel free to add them to this
- google doc here: goo.gl/fp09r-
: please include why the command is :
: useful (i.e. what you use it for).

: Once we have a list of sufficient
: length, I'll go through the

: commands and compile it into an
: article “cookbook”.

Create a folder hierarchy with a

Full circle magazine #74 @ 6

Survey Resulks

one-liner (Bash scripts): First off,

. this doesn't require a script of any
. sort. Mkdir (make directory) is the
. command-line tool Linux offers for
: this. Usually it will create only a

. single folder at a time; if you tell it
. to create a path, it will fail.

. However, it has a command-line

. argument “-p” (how | remember

. this is p=path, so make path,

. instead of directory), which does

. exactly what you want. Take this

scenario, for example: You want to
create a folder Summer in your

. Pictures folder, with two folders

within it called Tahiti and Montreal.

. This can be done with one single
: command:

mkdir -p

! Pictures/Summer/{Tahiti,Montr
: eal}

The -p argument will literally

. create directories as needed to
: reach the directories you want to

. create. So if Pictures or Summer
And now, on to some questions

that were fairly brief and would
. not have been enough for a whole
article in and of themselves.

: (or both) are missing, they will be

. created. The only caveat is that you
: can't put spaces between the

: commas. You can certainly make

: names with spaces though, as you

can see below:

h contents ©
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mkdir -p
Pictures/Summer/{“Tahiti
2013”,"Montreal 2012"}

As you can see, you can't place a :

space between the items and the
comma (mkdir understands it as
two paths then:
Pictures/Summer/{Tahiti 2013 and
./Montreal 2012} - as you can tell,
they won't even end up in the
same folder). Naturally, this also
works on Mac OS X systems, as
they offer the typical mkdir
command.

Another question | had was to
create a bash script to
automatically mount a second and
third hard drive. Once again, this
isn't a Bash problem. Linux offers
you a configuration File called
/etc/Fstab. This is in charge of
mounting all your drives on boot-
up. It will look something like that
shown below.

The following mounts an NTFS
drive to /media/Windows while
giving permission to access it to

# <file system> <dir>
/dev/sdal /

/dev/sda2 none
/dev/sda3 /home

the user Iswest and all users in the

group users. Edit the uid and gid as
. you see fit. You'll also need to :
- change /dev/sda5 to the correct

partition:

: /dev/sdab

: /media/Windows :
: uid=1lswest, gid=users, dmask=02 :
: 2, fmask=133
: 0 0

ntfs-3g

Example of mounting a FAT32

USB stick using UUID - again,
. change the UUID to the correct
. one:

UUID=47FA-4071
: /home/lswest/USBvfat
: defaults, noatime 0 0

: sudo mount -a

. by running:
<type> <options>
ext4 defaults, noatime
swap defaults
ext4 defaults, noatime

sudo blkid

Or, if you want the UUID for a

! sudo vol_id -uid /dev/sda2

Replace, of course, sda2 with

: the actual drive you want.

Lastly, there were a few

: requests for covering GRUB2.

. While that would be an article in
- itself, I felt I should at least offera :
. little bit of information for those
. who don't want to wait. For GUI-
. based editing of some settings,

. there's grub-customizer:

. https://launchpad.net/grub-
If you want to use spaces in the :

. paths, you need to replace the

. spaces with \040 in the file. Once :
. you edit /etc/fstab, you can test to :
. see ifit's working by running:

: customizer

If you're just after a different

. theme, they are discussed at the
following links:

: https://help.ubuntu.com/communi

ty/Grub?2

: If the drives show up where you :
. expect, and you can access them,

: you're all set. You can check UUIDs 6183/how-can-i-get-some-nice-eve-

. candy-themes-for-grub

. http://askubuntu.com/questions/6

<dump> <pass>

0 1
0 0
0 2
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https://help.ubuntu.com/communi

; . ty/Grub2/Displays
. single drive/partition, you can use:

Hopefully I've answered the

. questions sufficiently. If anyone

. has any further questions, feel free
. to email me at

. [swest34@gmail.com. Please

. include “C&C” or “FCM" in the

. subject line. If anyone has any

. suggestions for topics | should

. cover, you're also more than

. welcome to email me about them.
: Judging by the survey, it seems a

. great deal of you have suggestions
. or questions. The problem with

. some is that they are too specific

. for an actual article - but if you

. email me | can probably set you on
the right path to fixing it.

&

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: [swest34@gmail.com.
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odcastlng has revolutionized
the way we create, share, and
distribute content over the

Internet. Nearly everyone is aware
- video podcasts to MP3 audio.

iTunes, and most people are aware :

of some of the various open source i:ﬁ: apt-get install gpodder

of programs such as Apple's

podcatching alternatives. Several

of these applications provide ways

to download episodes on a
schedule, however, for the most
part, these programs usually
download every episode of every
subscribed podcast. Many people
subscribe to far more shows than
they could ever actually have time
to listen to.

We will introduce a system to
download only the specific
podcasts we listen to regularly.
Our solution will convert video

podcasts to audio MPEG-3, so all of :

: 2600: The Hacker Guarterly
Cff Tha Hossk ansd OFF Tre Wiall

our episodes are ready to be
copied to a CD, MP3 player, or
similar device.

SETUP GPODDER

Gpodder is the podcatching
software we will use to manage

HOW-T0O

Written by Neal Bailey

our subscriptions. The first step is
. toinstall gpodder (which should
. install the package we really want,

gpodder-cli), so we can convert

When you run gpodder for the

 first time you will be prompted to
. subscribe to podcasts, import an

. opml file, or sync with your

. gpodder.net account.

| recommend creating a

. http://gpodder.net account

: because it allows you to subscribe
: to podcasts from a friendly

© website interface and, more

© importantly, it allows you to sync
: all your subscriptions to multiple

. computers.

 SeT uP FFMPEG

gFPodder

W EpscBattisAxe » Podcasts
: - L#t Your o s Be Heara'

gUE] 105

r——
| | All spisodes
d from sl podcasts

Ehl The Ben Heck Show (HD MP4 - 30fps)

Joir master hacher, engineer, and conprer of (ool itu

- Buzz Out Loud [MP3)
@ Burr Out Lous freen CNET ghves you 3 uragas Lk on

...
g Full Crcle Magazine » podcast
e The Full Crois Podcsil, prosuded i BL560 a0 with F
GATV com Web Shows .
: -rumlm.rc.l-...umunqm,. "’B
¢ Game informer Podcasts 2]"

|l GamasTrailers.com - Bonus Round

Invisible Walls - Episode 213

Hawien ttog by for tome m

Invisible Walls - Episode 212
Lotipop Chariew. Dt Showdown. and tons

o h-taculer g

ﬁ Inwl-lbh Walls - EX 5p«lil Day 4

faviteey are unf orturately over a1 we lo

i Invisible Walls - E3 Specisl Day 3
We've noowred the E 3 hally to being you the Be

ﬂ Invisible Walls - E3 Special Day 2
Lack of sieep mspres wa' Insght on Nirt endo

-‘ Invisible Walls - E3 Special Day 1
Tewe W crew wstiches. dogs and shakes down

i Invisible Walls - Episode 211
Tre £ 3 pre

ﬂ' Invisible Walls - Episode 210
Thee developer of Spec Ops: The Line Stops by

thow i here’ Mightmnasre and dres

Podcasts Subscriptions Episodes Dewce View Help
=
Podcasts (26) | Dowrloads
[ Epesode Size Released =~

1.1 KiB 062272012

3.5 KB 061672012

288.0 MiB D6MOBI2012

216.4 MiB DGMOT/2012

296.5 MiB 0662012

309 4 MiB 0652012

¥98.0 MiB 0B/02/2012

420.0 MiB 0572572012
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Gpodder: Your Entertainment Assistant

. devices (or burned onto CDs for

: the car). You may want to get the

. most recent version of ffmpeg.

. Typically this will require compiling
. ffmpeg from source.

Please refer to this howto for

compiling fFfmpeg:
: https://ffmpeg.org/trac/ffmpeg/wi

One of the core features of our ki/UbuntuCompilationGuide

: setup includes the ability to

: extract the audio from video

© podcasts so, when each download
. completes, we are left with a set of
© MPEG-3 audio files which can then
: be synchronized with our portable

Or, you could install ffmpeg

. from the Software Center or using
. Synaptic.

. MANUALLY TESTING THE
. SETUP

Before we go about creating

: the bash script and cron job to

. download and convert our
podcasts, we want to run some

© manual tests to ensure the

: machine is properly prepared. We

: have subscribed to EpicBattleCry, a
: video games podcast from the

: guys at

: http://www.gametrailers.com.

: Enter the following commands into
: the bash shell (skip lines that begin
" with # as these are comments)
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http://gpodder.net
https://ffmpeg.org/trac/ffmpeg/wiki/UbuntuCompilationGuide
http://www.gametrailers.com

HOWTO - GPODDER

# update and download

podcast

# enter these 2 lines into
the bash shell

om/gteba_podcast .xml

gpo update S$URL && gpo
download $URL

You should see the latest
episodes getting updated and
downloaded.

This specific podcast is a video
podcast, which obviously won't
work on a CD player or standard
MP3 player, so we need to extract

the MP4 video file.

# extract audio from video
file and convert to MPEG-3

# change the file name to
match a file that was
downloaded in the previous
step

DLFILE=$HOME /gpodder-
downloads/"EpicBattleCry -

GameTrailers.com"/skirmish——
186——-i-want-to-bite-it .mp4

# run ffmpeg

ffmpeg -i $DLFILE -vn -ac 2
—-ab 192k "S$DLFILE.mp3"

AUTOMATING THE SYSTEM

At this stage we have installed

Obviously, performing these

tasks at the terminal is
. cumbersome and time consuming.
: Next up we are going to automate :

and encode the audio stream from the solution so these tasks occur

on their own, based on a schedule.

: GPODDER-SYNC
. gpodder (gpodder-cli) and ffmpeg,
URL=http://www.gametrailers.c5 and we used the gpodder user :
: interface to subscribe to a podcast.
: We then updated and downloaded
. the newest episodes from the

. command line. Finally we used

. ffmpeg to extract the MPEG-3

. audio stream from the MPEG-4

. video podcast.

When we are all done with our

. script, it will look like the image
. below. Before we can get here

: though, we'll need to set up the
. configuration and modify the

. gpodder settings.

CONFIGURATION

Create a new file called auto-

. downloads.confand place it where
- you like. In my setup, it is located i |n
: SHOME/Downloads/Podcasts/

.| File Edit View Search Terminal

Help
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In this file, paste the Internet URL
addresses of each of the shows

. that you want to auto-update (one
. per line).

These podcasts can be video or

audio podcasts. If they are video

: podcasts then our script will

. convert them to audio podcasts for
. you.

At present, the script handles

- only MP3 and MP4 files. For the

. podcasts | download, these appear
. to be the standard file-types in

. use. The script can be easily

modified to handle more file-types

. if necessary.

. SCRIPT

Download the bash script here:

. http://pastebin.com/xyxBMhZ8,
: and copy into your home or ~/bin
. directory. Open the script in your
. editor of choice and replace the

. following values to match your

. system.

LOG

This is the path and filename to

write log messages to. You can
: change it if you don't want to log

to /tmp
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log="/tmp/$ (date +%Y-%m—
$dT%H: $M) —podcast-—
download. log"

DEFS

This is the File containing the
URLSs of the podcasts to
automatically download. This File
must exist prior to running the
script.

defs="$HOME /Downloads/Podcast :

s/auto-download.conf"

PODDOWNLOAD

is configured to download. It is
usually ~/gpodder-downloads
unless you manually changed this
value in the Preferences > Edit
Config button in gpodder. On my
machine, | have changed the
default gpodder download path
(to the path you see below)

podDownload="$HOME/Downloads/; cd ~/bin &&

Podcasts/gpodder—-downloads"

PUBDIR

This is the path to copy
downloaded and/or converted
podcasts to. It is created if it
doesn't already exist.

pubDir="$HOME/Downloads/Podca
sts/_converted"

. HISTFILE

This is the path to the file used

to record which shows have

. already been downloaded or

: converted. It is created if it doesn't
. already exist.

. TEST THE SCRIPT
This is the path where gpodder

Now that we have updated the

script, we need to test thatit's
- working correctly.
E # make it executable

; chmod +x ~/bin/gpodder-
: sync.sh

; # run the script

Hopefully the script updated
your specified podcasts and then
downloaded (and converted if
applicable) them to your pubDir
folder.

./gpodder-sync.sh :

DOWNLOAD SCHEDULING

Now that our script is running

. and everything is set up, we need
© to create a scheduled task so the

: script is run automatically once a

. day. In the example below, we are
: running the script every morning

: at 10:30 am.

! # open crontab

: histFile=”$HOME/Downloads/Pod;
casts/_converted/_history.txt |

on

crontab -e

; # enter this line into the
i crontab (replace neal with
: your username)

30 10 * * *

: /home/neal/bin/gpodder-
! sync.sh

NEXT STEPS

This process is ideal on a

. headless server. I've been running
© this script for a few years now on a :
. Ubuntu server. In this :
: configuration you can set the

. pubDir to a SAMBA share. Now

: everyone in the house can sync

© their devices to the shared folder.

Feel free to send me feedback

or questions. | hope you enjoyed
© this tutorial.

Full circle magazine #74 @ 10

Neal is a software engineer and
enterprise services consultant for an
international PC firm. He has been
using Linux since 1998 as a hobbyist,
and loved every minute of it. He can
be reached by email at
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he LibreOffice Draw module is

a vector graphics application
included in the LibreOffice suite.
Draw lets you create graphics you
can use in your documents. While
there are more advanced vector
graphics programs — such as

Inkscape — Draw provides you with
- them at a later time.

more tools than most drawing
packages included in other office
suites.

Vector graphics create images

by defining geometric shapes such :
as circles, rectangles and polygons, :
: the new, open, save, copy, cut,

: paste, and other functions that

© pertain to most modules. The line
Bl Uitiod 1 ; LibraoMics Oraw
: | Ebe Edit Niew |nsert Fgreat Tools Moddy Window Help

rather than by pixel points on the
screen. Because of this, vector
graphics scale without distortion.

As with the other modules in
LibreOffice, Draw integrates well
with the others, making it the tool
of choice when creating graphics
for your documents.

THE DEFAULT LAYOUT

The default layout for Draw is
rather sparse. You will probably
want to modify it to include the
toolbars you use most often. The
layout includes the basic elements

HOW-TO

Written by Elmer Perry

: you need to create a graphic

: image. The center of the screen is
: the area where you will create your :
: graphic. To the right, you have the
: page pane, showing the different
: pages of the graphic. Multi-page

: graphics are used mostly for

presentations, and | will cover

LibreOFFice Pt27: Intro To Draw

and fill toolbar sits below it. This
. toolbar controls how the lines and

fill of an object will look. At the

: bottom of the window sits the

: drawing toolbar. From this toolbar,
© you can create most of the objects
© for your graphic. You can move the
: toolbars by grabbing the handle at :
. the beginning of the toolbar and

: dragging it to the location where

By default, you have three

toolbars. The standard toolbar is
: the topmost toolbar. This is the

toolbar you see in most of the
LibreOffice modules. It controls

. you want it.

The status bar at the bottom of :
: the window gives you a lot of
. useful information about the
: object you are editing. An object’s :
: type, dimensions, angle, and other
. useful information will show up

& - B & 8 T & & o R
E o B ~||Bo- ol (Mmosy | S (Celer o L Jaes =) O
Fages T 3 1
1
o :
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.XK \\.
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. here. I will refer to the status bar
. often during the How-tos on Draw.

: At the top and along the left

. edge sit the rulers. The rulers are
. guides to where you are in the
image. If you want to change the

: unit of measure in the rulers, you
. can right-click the ruler and select
. a different unit of measure. When
. you have an object selected, the

. ruler shows double lines to
indicate the object’s position on

. the drawing.

P00

. THE COLOR BAR

The color bar displays the
current color palette under the

n contents ©
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drawing area. You can use it to
select colors for your objects
rather than having to use the
dropdown list in the line and Fill
toolbar. The first box — the white
box with an X in it —is the no color
(orinvisible) selection. To display
the color bar, go to View >
Toolbars > Color Bar. To use the
color bar, left-click the color you
want for the fill color of the object, :
and right-click to select the line
color.

TEAR-OFF TOOLBARS

Many of the icons on the
toolbars have a triangle or arrow
to the right. This indicates the item :
is expandable. Clicking on the ;
arrow gives you more choices. You

| F e e
1AM DO &
GRGAOLEIONA
|8@ D O

-0 @3¢ 00

LS

""-.
L
]

can detach these items from the
toolbar, creating a floating toolbar.

. When you expand the item, you

. will see a grab bar at the bottom.

: Click and drag the grab bar to

: create a floating toolbar of the

. items. This is helpful when you

: need to use the items repeatedly,

. and is quicker than having to :
. expand the items each time. When :

you are finished, just close the

. floating toolbar by clicking on the
. close button in the title bar.

GRID, SNAP LINES, AND
. SNAP POINTS

When creating an image, | find
it useful to have guides to work

points are useful for such guides.

Basic Shapes * X
F e Ne®

GANTGOS
OO Or@ &
U@ D O

opt 0 [ £
= Libredffice -
Grid
User Datka . )
General [] sngp to grid
Memaory I - L
- W1 Wisible grid
Pri . 3
P':Il:11"-:5 Resolution Subdiy
Colors Hgrizontal 0.10" B Har
Fonts _ =
Security Wartical 0.10" El verl
Appearance -
Accessibility [l synchronize axes
ava
b Lnélclr&.aue Shag Snap |
¥ Language Settings ] T smapk lines .
= LibreQffice Draw . :
General [] To the gage margins 1
Loy [ To object frame o
3]
Print ¥ Ta abject points o

. Options > LibreOffice Draw > Grid.
. If you want objects to snap to the

. grid by default, check the Snap-to-
. grid checkbox under grid. You also
: have the option to make the grid

. visible by default. Resolution sets

. the vertical and horizontal settings :
. for the grid. Subdivision sets the
. number of markers between the

You can set the program to snap to
. these guides, which help you

. precisely place your objects in the
: . drawing.

- from. The grid, snap lines, and snap :

than too much. You can set certain

: snap options on by default under
. the snap section, but | recommend
. leaving these all off by default,

. and using the options toolbar

To set up the grid, go to Tools > :

. horizontal and vertical grid points. :
: The more subdivisions the more
. precise the changes when snap-to- :
: grid is on. But like most things,a

happy medium is usually better
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I ew snap object ~m

when you need to turn them on.

. Use the snap range to control how
. close to a snap point you are

. before your object snaps to the

. point.

Position
DK

X 1o =
Cancel

-~

¥ .10 5

Type Help

Point

#e Wertical

-§  Horizontal

h contents ©



HOWTO - LIBREOFFICE Pt27

Unlike the grid, snap points and
snap lines are inserted when you
need a more exact location. Snap
lines are great for aligning objects

a snap line or point, Insert > Insert
Snap Point/Line from the menu
bar. The X position controls the
distance from the left of the
image. The Y position controls the
distance from the top. The type

a snap point, vertical snap line, or
horizontal snap line. You can also
create snap lines by clicking and
dragging from either the
horizontal or vertical rulers. To

back to the ruler. To delete a snap
point, right-click the snap point
and select Delete Snap Point.

OPTIONS TOOLBAR

your snap options. If it is not
showing, select View > Toolbars >
Options. On the toolbar, you can

Guides display

ol

toggle whether your guides are
displayed, and toggle on and off

. the snap options. You might want
: to dock this toolbar to the bottom
vertically or horizontally. To create : ©' S'd? of your window as | suspect
. you will use it often to toggle

. these options.

There is one more guide on the

. CONCLUSION

: LibreOffice Draw is the graphics :
. application of the LibreOffice '
. suite. Draw saves graphicsin a
The options toolbar contains all vector graphic format for U,SG In
. your documents created with

. other applications in the suite.

. Draw provides you with the tools

Shap Toggles

L IS

to combine text and geometric
objects to create your graphics.

: Guides, and the ability to snap to
. the guides, help you to precisely

place your objects.

In the next LibreOffice How-To,

. we will look at creating basic
: . objects in Draw.

. toolbar we have not discussed yet. :
. Itis the helplines. When you select :
controls whether you are inserting the helplines on the options

. toolbar, then, when you move an
. object, dashed lines appear from
. the corners of your object to the
- rulers. The helplines are just one
. more tool to help you accurately

delete a snap line, click and drag it place your objects.

=

Elmer Perry's history of working,
and programming, computers
involves an Apple IIE, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
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ubuntu

uk podcast

(@)

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us First hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
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m Written by Alan Ward
he 2008 Beijing Summer
Olympics brought IPv6 to the

attention of the technical crowd,

with Further reminders on World

IPv6 Day, 8 June 2011, and World

IPv6 Launch Day, 6 June 2012. We

are, for the most part, informed

that the current IP (IPv4) address
space is running out, and that
sometime in the short to middle
term we will need to get to using

IPv6 addresses and connectivity to :

the Internet.

This is not quite yet the case for
. IPvé-enabled version of the Web.

most people. Internet Service
Providers have not rolled out
native IPv6 access in many
countries. Most servers still have

of Internet giants such as Google,

Facebook and several others. Much : - .
: native connection to the IPvé6-

. enabled Internet, we shall need
: the services of a tunnel broker.
: This is the equivalent of an

: Internet Service Provider, but

: instead of giving access to the

: Internet for individual lines or

: devices, it gives access to the IPv6-
. enabled Internet starting from a

of the hardware available
(specially in the domestic
category) still handles only IPv4.
But things are changing, and we
will need to get to it. Going dual-
stack, i.e. having both IPv4 and
IPv6 activated at the same time, is
a nice way of making the
transition.

HOW-TO

Luckily for us, Debian, Ubuntu

: and most other GNU/Linux

: distributions are well up to speed
: as regards IPv6. The Linux kernel
: itself handles IPv6 quite well, GNU :
. user-land applications have been
: adapted or ported to IPv6, and

: most widely-used GUI programs

: are now capable of making use of
© IPv6 connections - actually, when
. both IPv6 and IPv4 are present,

they tend to prefer IPv6.

So, in a way, Ubuntu is ideal to
make a first contact with this new,

. CONNECTING TO THE

only Pv4 access, with the exception INTERNET WITH IPV6

Supposing we do not have a

normal IPv4 address. We will be

Connecting To IPV6

© creating an IPv6 tunnel from our
: computer to the tunnel broker,

: through the IPv4-only fabric that
. lies between us.

Several tunnel brokers are

© available, both free and
commercial. Two in the former

. category are SixXS

- (http://www.sixxs.net) and Gogo6
. (http://www.gogo6.com). In both
: cases, the necessary software is

: open, free, and readily available

. from the Ubuntu repositories.

For Gogo6, we need to sign up

© for their Freenet6 IPv6 access
. service, at
http://www.‘gog06‘.;com/Freenet6/a . 00-00-00—-00-00-00-00-00-00
: ccount. Each of their servers works :
: independently from the others, so
. remember which one you are on
© (choose the one you think is best
© accessible from your country).

: Once we have confirmation of

: being registered, we need to
install the software:

; sudo apt—-get install gogoc

Naturally, we could also use a
graphical program such as
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! tun

! Scope:Global

Synaptic, Ubuntu Software Center,
: or Muon.

We then need to edit the

. configuration file

: [etc/gogoc/gogoc.conf with the

. username and password the server
: gave us, and restart the service

© with

; /etc/init.d/gogoc restart

We should then be able to see

the tunnel with the ifconfig
: command:

; ifconfig

Link encap:UNSPEC

: HWaddr 00-00-00-00-00-00-00-

inet6 addr:
2001:db8::101/128

UP POINTOPOINT

RUNNING NOARP MULTICAST
: MTU:1280 Metric:1

In this example, our IPv6

: address would now be

: 2001:db8::101 . Since this is just an
: example, | chose a (relatively)

. simple address—real IPv6

: addresses may need be written

~ with up to 32 hexadecimal digits,
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grouped into eight four-digit
groups.

broker, the registration process
may be slightly slower (it took
slightly less than an hour for me)
since it is not completely
automated: real human beings
process our request. We can then
request a tunnel be activated for

us, and, optionally, an IPv6 address . .
P Y . slightly different way than the

: Gogo6 version (note the /64

. segment, instead of a single host
: /128 address), and uses identifier
: “sixxs” instead of “tun”.

subnet. The tunnelis all we need
to access the IPv6 Internet on a
single computer; the subnet is
needed if we chose to connect a
complete local network through
our machine.

For SixXS, the appropriate
software package is aiccu:

sudo apt—-get install aiccu

When we have edited
configuration file /etc/aiccu.conf
with the username and password
given by SixXS, we can restart the
service:

/etce/init.d/aiccu restart

and we should then be able to
see the tunnel with the ifconfig
command:

ifconfig

sixxs Link encap:UNSPEC

. HWaddr 00-00-00-00-00-00-00-
If we choose SixXS as our tunnel :

00-00-00-00-00-00-00-00-00
inet6 addr:

; fe80::40:fe00:229:2/64
: Scope:Link

inet6 addr:

UP POINTOPOINT

RUNNING NOARP MULTICAST
: MTU:1280 Metric:1

This one is configured in a

speed test ping test

If things have gone well so far,
either with Gogo6 or with SixXS,

: we can now use the IPv6-activated
. versions of network tools to check
: connectivity, such as ping6 (instead :
. of ping) and traceroute6 (instead

: host ipv6.google.com

: ipv6.google.com is an alias
: for ipv6.l.google.com.

: ipv6.l.google.com has IPv6
: address

: 2a00:1450:4001:c02::63

; ipvé6.google.com(2a00:1450:400 :
: 1:c02::68) 56 data bytes

website test statistics api

forum ==

64 bytes from
2a00:1450:4001:c02::68:

. icmp_seqg=1 ttl=51 time=228 ms
: 64 bytes from

: 2a00:1450:4001:c02::68:

: icmp_seg=2 ttl=51 time=228 ms

64 bytes from

: 2200:1450:4001:c02::68:

: : ! icmp_seq=3 ttl=51 time=229 ms
 2001:db8::101/64 Scope:Global | of tracerqute).Other tools, such as |

: . host and ip, work in the same way

both for IPv4 and IPv6. So:

Since we now have IPv6

: connectivity with the Web, we can

. browse IPv6-only web pages. Some
. classical destinations to try out

- IPv6 are the dancing turtle at

: http://www.kame.net (it dances

- only if we connect through IPv6),

. ping6 —-c 3 -n ipv6.google.com§ or the test pages at
. PING

: http://www.test-ipv6.com or

. http://www.ipv6-test.com.

When both protocols are available, your browser uses

IPv6

Your internet connection is IPv6 capahle

[Pvii-test.com is a free service that checks your IPv6 and IPvd connectivity and speed. Diagnose connection problems, discover
. 'which address(es) you are currently using to browse the Internet, and what is your browser's protocol of choice when both v6
: |and v4 are available.

ol | ; Javl B b o BT
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DiFFiCcULTIES WITH IPV6
AND UBUNTU

We have just set up a dual IPv4
and IPv6 stack; our computer is
connected directly to the IPv4
Internet through our usual Service

Internet through the tunnel
broker. But if we had not set up or
do not activate the tunnel, our
computer can be in a situation in
which it has a working IPv4
connection, but not so with IPv6.

Ever since most modern
operating systems activate IPv6 by
default, this has given rise to some
confusion. Many programs are
capable of handling dual-stack
access, they prefer to use IPvé6 if
possible and if not fall back to
IPv4. But other programs cannot
handle this, which usually ends up

causing delays that annoy the user.
| ] http:/7[2001:db8::101)/

Some programs even complain
about “not being able to connect
to the Internet” - even though a
perfectly good IPv4 connection is

up.

This is now more-or-less fixed
for software on Ubuntu, though
with previous versions it was

sometimes necessary to deactivate
IPv6 at kernel level. One option

. was to blacklist the ipv6 kernel

. module, as mentioned by Robert
. Clipsham way back in number

- seven of FCM. Another possibility
. with recent kernels is to disable

. IPv6 through the procinterface:

Provider, and indirectly to the IPv6 :

: echo 1 >
: /proc/sys/net/ipv6/conf/all/d :
: isable_ipvé

However, it should be stressed

. that these difficulties should no
: longer come up under Ubuntu:

. whichever order in which a :
. program chooses to connect to the :

WORLD-REACHABLE

. ADDRESSES

. The nice thing about IPv6 is that :
. Network Address Translation (NAT) :
: and private addresses, ubiquitous
. in the IPv4 world, are no longer

. used. The reason is that since there :
: are so many public IPv6 addresses
- available, it will not be necessary

. to re-utilize them many times over
: in the Form of private addresses

: that are not routable through the
. Internet.

The corollary is that the

- using IPv6 are directly reachable
. from all over the Internet. Nothing
. stands between us and the wild :
. world out there.

This can come out as an

- Mozilla Firefox

Fitxer Edita Visualitza Historial Adreces d'interés Eines Ajuda

LR

= [2001:db8::101]

It works!

This is the default web page for this server.

The web server software is running but no content has been added, yet.
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advantage. Consider, for example,
the hoops some of us jump

. through in order to reach our

home machines from outside,
while on the road. Or to get into

. our work machines from home

. (though systems administrators

: may frown on this, and rightly so).

. With IPv4, we need to open a port
© in our router to enable access from
. the outside, and activate

. Destination NAT (DNAT) to make

. packets we actually send to our

© router's external address be resent
. inside towards a specific PC. And

: we must achieve this rather

. complex setup while at the same
: ) . computers we connect to the Web
- Internet, it should be able to do so :

. through one route or the other.
. Not so in other operating systems, :
- specially with commercial
. software.

. time taking into account system
. security.

With IPv6 and world-reachable

. addresses, this is no longer

. necessary. If, for example, my

. home computer has global address
: 2001:db8::101 and an Apache web

: server running, | can connect to it

. directly from outside my home by

. simply pointing any browser to the
. corresponding URL,

: http://[2001:db8::101] . If I set up a
. personal mail server, it can also be
. directly reached and mail sent to

. me from the Web.

But having our computers
directly reachable can also
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constitute a serious security risk.
So we need to be really careful
about what kinds of traffic we let
in.

To protect my home computer, |

can use my global IPv6 address to
set up a SSH or OpenVPN virtual
private network (VPN). This way,
full communication can be set up
for all protocols through an
encrypted and authenticated
channel. Even if somebody in
between may see my packets as
they pass through, they cannot
decrypt them and view the data
contained within. So we have a
strong argument in favor of
setting up a secure VPN, and
making sure our services can be
accessed not directly from the
Internet, but only through the
VPN.

Naturally, Ubuntu has all the

necessary tools in the repositories, :

both for the client and for the
server sides of the VPN. The
corresponding software packages
are ssh-server, openvpn and
network-manager-openvpn —

also exist.

Luckily, the Linux kernel Firewall
is also well up to the job, though it

Places v

—d

iTunes

U=l alan a 2001:dbg::1... &
I‘Dl:lr:umf_'nt:i

‘Mﬂsica

‘Imatges

= Baixades ‘
‘ uoc

. |1 item (2 hidden)

= Music - + X
Fitxer Edita Ves Adrecesd'interds Visualitza Eines Ajuda
o Lo« o | sftpi/falan@[2001:db8::101)/home/alan/Music "@

. does need to be correctly set up.

. The command-line way of doing

. this is probably not for the faint of
: heart, as it is relatively easy to

. leave out a rule and make things

: too easy for the bad guys—or

. being over cautious and

. inadvertently blocking yourself

: out. So a GUI tool such as

. firestarter may be a wise choice to
. begin with. :

If we set up some services we

. wish to share with friends—or just
. use for ourselves—we should also
: bear in mind the security

. implication of having a port open
though, as usual, other possibilities : to the worlc‘L Special attgntlon :
: should be given to securing access,
. especially when sensitive data can

: be accessed, e.g. though file

sharing. If all we want is access to

Since SFTP is actually based on

. SSH, it may be considered quite

. secure, especially if no-password,
. public certificate-only access is

. used.

For road-warriors, several apps

. can be found that do SSH and

. SFTP, both for iOS and Android.

. Unless, of course, you choose to go
- with Ubuntu on your phone or

. tablet, in which case finding

. suitable client software is simply a

. our files while on the road, SFTP is - matter of choice.

. probably the easiest service to set
. up. Basically, allwe need todois
. install package openssh-server on
: our home computer. We can then
. access it from any file manager

: that knows about SFTP (such as

. Gnome's Nautilus) using URL

. sftp://username@server_ip :

=

Alan teaches computer science at
Escola Andorrana de Batxillerat. He
has given courses at the University
and currently teaches GNU/Linux
systems administration at the Open
University of Catalunya (UOCQ).

The I(AM:E project

1998.4 - 2006.3

Dancing kame by atelier momonaga
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Written by Nicholas Kopakakis

J

L ast month we used Cycles
Render to create the image
shown below left.

Let's create a similar image
(below right) with the Blender
engine.

The first thing that we notice
(at least me) is shadows. The

shadows that our point lamp casts,

with blender render, are almost
black. This phenomenon is
happening because in Blender

by the lamp only. This isn't
realistic, as in the real world every

Interface Editing

object emits or reflects light.

On the other hand, Cycles

. renderer calculates the light that
. every object has from the

. surroundings. You can observe the :
. cone and see how the shadow

. from the cube smoothly fades

. (contrary to the cone from the

. Blender renderer), and we have a
- mirroring ground and a shiny metal :

. cube in our scene.
renderer, the light is been emitted :

One other thing that is very

. crucial, and a main difference

Blender - Part 6b

Input Addons Themes

between Blender and Cycles, is
. more technical.

Navigate to File > User

Preferences > System (above).

At the lower left corner of the

System Tab you can check if your
. computer has Nvidia CUDA
. support under Compute Device

MNone

GeForce GTX 660 Ti
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My GPU has CUDA support so |
. can enable it. You can also check it
: at the official CUDA support url:

. https:
. gpus

developer.nvidia.com/cuda-

If you are lucky and have an

. Nvidia CUDA card, you have to

. enable it under the Compute

. Device Tab that | mentioned

. before AND under the Properties

. Panel, Render Tab -> Device -> GPU
. Compute in order to have the full

. power for your rendering.
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about Cycles. Open the .blend file
. that we started last month, or just
. create a new one. Don't forget to

Select the sphere, navigate to
~ the Properties Panel and change
. the Surface shader from the

You can check in the Preview
. window the cool effect that we
: create. You can adjust the Color

Irmzage Editor

Supported

GPU Compute

Cycles can use your GPU CUDA

cores to render, and is much faster :

than the CPU. Check out CUDA at
wikipedia:

http://en.wikipedia.org/wiki/CUDA

If you don't have a CUDA GPU,
you can use Open Shading
Language, but it's a little bit buggy
and | couldn't recommended this
method of rendering, for now. In
the near future | have a feeling
that it's going to be much faster
than the CUDA render procedure.

Image Editor

Supported

4 Open Shading Language

But enough with the technical
stuff.

Let's see another great thing

Cycles Render

Blender Render

Blender Game

: Also change one of your 3d view
windows to show the rendered :
result.

Materal

Texture

Solid

Wireframe

Bounding Box

N At ribute

RGB
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check that the Cycles Render at the default Diffuse BSDF to Emission.
. top is selected :

Gradient Texture

ML

Magic Texture

Imaoe Texturne

. and the Strength of the light that

. your object emits. Also for every

. shader you can adjust a lot of other
. things (as textures, for example) by
. pressing the little dot right next to
. color and strength values.

Select our metallic-looking

. cube, press the little dot next to
. color, and change its texture to

. Brick Texture. Check the result in
. your 3d view window and select

. different textures until you find

. something that you like.

RGB Curves Combire RGB
Huee Saturation Val e
Bright/Contrast Wawvelength

Gamma
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TIP: The little dots are in every
shader, not only emission, and |

personally find them very useful to

quickly create interesting stuff.

Another interesting shader is
the Mix Shader. As you can easily

shader that you can use to mix
other shaders. Two other shaders
to be more precise. So, let’s select
our cone and change the Diffuse
BSDF shader to Mix Shader. Add a
Glass shader and a Diffuse shader
or a Glossy Shader and an
Anisotropic Shader to our cone.
Change the value of the Fac
parameter to adjust the
percentage of the second shader
(0.000 means 0% while 1.000
means 100%)

Check the result on your
preview window and adjust the
settings as you like.

Another thing that | want to
mention in this tiny little
introduction on the Cycles
Renderer, is the use of planes
instead of lamps.

Most people working in Blender
and Cycles use planes to illuminate :

their scenes. Looks like more “real

world” lighting, and | have no

~ reason to argue with them.

Below is where | am so far.

For this month, follow this link

http://vimeo.com/68010380 to
understand from its name, thisisa : enjoy a wonderful work by 3

. people and Blender

. (congratulations goes to Javier

. Trapiella, Baol Bardot Bulsara and

. Robert Green).

Also visit www.blendernews.org

~ to enter and share with thousands
. of professional artists! '

http://blendernews.org/xe/?mid=F :
. eature Articles&document srl=12 :
. 14
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=

Nicholas lives and works in Greece.
He has worked for a post-production
house for several years and migrated
to Ubuntu because “it renders
faster.” You can email him at:

h contents ©


mailto:blender5d@gmail.com
http://vimeo.com/68010380
http://blendernews.org/xe/?mid=Feature_Articles&document_srl=1274

Written by Mark Crutch

W

Inkscape - Part 14

T'F’éhsparency— orits :
counterpart, opacity —is such a :
: cause that part to appear

transparent. And grays in-between :
- resultin varying levels of opacity.

fundamental concept in Inkscape
that it was one of the earliest
topics covered in this series. Back
in Part 3 you were introduced to

the Opacity spin-box on the status :
: image (below) I've placed a solid
: red circle on top of a solid green
: background. The green is there
: mainly to show the effect more
: clearly. On top of the circle is a
© rectangle with a white-black-white :
: gradient. Using this rectangle as a

mask For the circle gives the result edge, but, as we will see later in

© this article, there are times when

bar, which gives you the ability to
set a single transparency level for
a whole object, or even a group of
objects.

If you want a single object to
have varying opacity — such as

completely transparent at one end,
: of a clipped circle that fades from

opaque to transparent and back to
© opaque.

and opaque at the other —you can
use a gradient for the fill and
stroke. But what about doing the
same for a group of objects? You
could set suitable gradients on
each individual item in the group
separately to get the desired
effect, but if your group contains

lots of objects, then that approach

becomes tedious very quickly.

The solution to this problem is
masking. This is a technique that
uses a grayscale image as a means
of specifying the opacity of

another object or group. Any white

sections in the image cause that

5 part of the masked object to

appear opaque. Black sections

Note that anything outside the

: mask is clipped. In that respect,

© masking could even be used as an
. alternative to the clip paths that

: were introduced in the previous

, _ part of this tutorial. Draw your
Let’s look at an example. In this : mask entirely in white — or in solid
. shades of white and black - and

© any parts of the masked object

. which lie outside the mask, or

: which are colored black, will be

: clipped. Usually | recommend using :

: if you simply want a hard clipped

. it's easier to use a mask.
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You may recall that the fill and

stroke of a clip path are irrelevant
. to the final effect on the clipped

. object. With masks, however, the

. opposite is true - the color of each
. individual pixel is taken into

. account when calculating its effect
. on the masked object, so fills and

. strokes have significance.

Did I say pixel? In a vector

© format? In practice, there are few
- aclip path in preference to a mask | C35€S where an SVG file is actually
. used as a purely vector format. If

: you want to display an SVG file on
: acomputer screen, or print it to an
. inkjet or laser printer, it is

. ultimately converted to pixels.

. Masking takes place during this

. final output step, so although the

. mask may be made up of vector

. objects, and the item being

. masked is also a vector, the final

: resultis really generated only at

: the point that those vectors are

. converted to individual pixels for

. display or printing.

Using a thick-stroked rectangle

and strictly black or white pixels,
. it's easy to see the difference
" between a clip path and the use of
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a mask to simulate clipping. In the
top pair of images, I've used the
rectangle as a clip path, and you
can see that the result is aligned
with the center line of the stroke.
The second and third pairs of
images show the rectangle being
used as a mask, with only white
parts remaining and black parts
becoming transparent. It's

the stroke has an effect.

By now it should be clear that

. clipping and masking are similar
: operations, so it's not really

: surprising that Inkscape exposes
: them with the same user interface. :
: Just as with clipping, the masking
: object must be on top of the object :
: to be masked, in terms of the z- :
: index. You then select both items
} i ) . and choose Set Mask from the
especially clear in the last pair that . context menu, or Object > Mask >
. Set from the main menu. Releasing :
: a masked object is as simple as :
. selecting it (it will be described as
: “Masked” in the status bar) then

. choosing Release Mask from the

: context menu, or Object > Mask >
. Release from the main menu. Just
: as with clip paths, it is possible to
. edit masks using the node tool

: without releasing them first, but

. generally there's little benefit to

: doing so as you can edit only the

: outline shape of the path, not its

: color.

As you've seen, using a

: you some control over the opacity
. of the masked object. You may also :
. recall that Inkscape offers a

. selection of black and white

: patterns in its Fill & Stroke dialog,
. plus a few grayscale bitmap fill

patterns. These may previously

have seemed rather limiting, but
their monochrome nature makes
them perfect for use as a mask.

: The checkerboard patternisa
good example of a situation where :
. it's easier to use a mask than a clip

. grayscale gradient as a mask gives path. This same effect could be

: achieved by clipping with a
: complex path, but it's probably not :
: worth the extra effort. Looking :
: closely at the checkerboard, you'll :
© notice that the Ffill isn't made up of :
: black and white squares, but rather
© white and transparent. Using white

and transparent can sometimes
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make it easier to see what parts of
an object you are masking: white

© areas will remain visible, and

© transparent areas will be clipped. A
: translucent white area will have

© the same effect as a shade of gray.
© It may seem counter-intuitive to

© cover the parts of the object that

: you want to keep, and expose the

© parts that will be hidden, but that's
© the way that masking has been

. defined in the SVG specification, so
that's the way it works in Inkscape.

Because clip paths are defined

© by a boundary and a concept of

: what's inside and outside that

: boundary, it's possible to use only

© asingle path or object to define a

© clipping shape. Masks, on the other
: hand, are concerned with only the

: color of pixels, so it doesn't really

© matter whether your mask is made
© up of a single object or a whole

: load of objects inside a group. This

allows you to create complex

. arrangements of colors and
: patterns which would be
. impossible to reproduce using a

single path.

This example uses a group
made up of a few random objects
as a mask. You can see that the
repeating radial gradient of the
rectangle, made up of a white-to-
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transparent transition, results in a
similar pattern being visible from
the masked red circle. But by
adding extra black and white
features to the mask group, you
can “override” the pattern with
explicit sections of transparency
and opacity. One thing to note is
the place where the black line
crosses the white one: because the :
black line is on top, the pixels at
that position are black, so that part :
of the masked object is :
transparent. It doesn't matter
what's going on within the group,
all that matters is the color of the
final pixels. This may not be the
best piece of abstract art in the
world, but it would have been a lot
harder to draw without using
masks.

Although you can use masks to
create complex arrangements of

: clipping and transparency,

. probably the most common use is
: simply to add “feathering” to the

. edges of a group so that it fades

© into the background. In that case

- all you need for your mask design
: is a strongly blurred white ellipse,

as demonstrated in this wholly

: unseasonal greeting card design.

Throughout this article I've

. referred to masks as being

: grayscale images. That's not

: strictly true — a mask can be any

: combination of colors that you

. want. However, anything other

: than white, black or gray will be

: converted into a grayscale image
. before it's used as a mask. This can :

make it difficult to predict the

exact effect of a color on the
resultant opacity, so | recommend

using pure grayscales when
- drawing your masks in almost all
cases.

|['EE|

Mark has been using Linux since
1994, and uses Inkscape to create
two webcomics, 'The Greys' and
'Monsters, Inked' which can both be
found at:

http://www.peppertop.com/
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Written by Ronnie Tucker

GUIDELINES

he single rule for an article is

that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu

RULES

* There is no word limit for articles, please Follow these guidelines :

but be advised that long articles
may be split across several issues.

* For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471

 Write your article in whichever
software you choose, | would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

* In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

. document.

* Images should be JPG, no wider
: than 800 pixels, and use low
: compression.

(Kubuntu, Xubuntu, Lubuntu, etc). : * Do not use tables or any type of

. bold or italic formatting.

If you are writing a review,

When you are ready to submit

your article please email it to:
. articles@fullcirclemagazine.org

. TRANSLATIONS

If you would like to translate

: Full Circle into your native

. language please send an emailto
: ronnie@fFullcirclemagazine.org and '
. we will either put you in touch with :
: an existing team, or give you :
: access to the raw text to translate
. from. With a completed PDF, you

- will be able to upload your file to

. the main Full Circle site.
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Write For Full Circle:Magazine

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

title of the game

« who makes the game

e isit free, or a paid download?

» where to get it from (give download/homepage URL)
* isit Linux native, or did you use Wine?

» your marks out of five

» a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

» make and model of the hardware

» what category would you put this hardware into?

* any glitches that you may have had while using the hardware?
* easy to get the hardware working in Linux?

« did you have to use Windows drivers?

» marks out of five

» a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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Secure

SYNC

Easy

SHARING

Online

BACKUP

Whether you need to access a document you have stored
oh a remote server, synchronize data between a Mac,
Windows or Linux device, share important business
documents with your clients, or just rest easy knowing all of
your data is safely, securely, and automatically backed up -
SpiderOak’'s free online backup, online sync and online
sharing solution can handle all your needs!

SpiderOak offers a different approach to online backup by
combining a suite of services into one consolidated tool -
free online backup, synchronization, sharing, remote access,

Access all your data in one de-duplicated location and storage. This difference is further measured in our zero-
_ _ o knowledge privacy policy - the first one ever employed in
Configurable multi-platform synchronization this setting. Our flexible design allows you to handle data

from any operating system (Mac, Windows and Linux) or
location (external drives, network volumes, USB keys, etc...)
using just one centralized account.

Preserve all historical versions & deleted files
Share folders instantly in web ShareRooms w [ RSS

Retrieve files from any internet-connected device

Comprehensive 'zero-knowledge' data encryption = :
Download mobile clients

©C © 0 © © ¢

2 GBs Free [ $10 per 100 GBs / Unlimited devices

furiOS&Android/ GEIZFFEEGBS

https://spideroak.com

Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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ASK THE NEW GUY

H i, everyone! Welcome back to
Ask the New Guy!

If you have a simple question,
and you think Ubuntu Bug #1 is
some kind of flying roach, contact
me at copil.yanez@gmail.com.

Today's question is:

Q: How do | connect to my
Ubuntu desktop using my
Android phone?

A: Right this way, Mr. Bond! Q
Branch has been working on some
new toys for you. How about this?
It's a combination martini shaker-
slash-Taser. No? Well, then,
perhaps this combination cufflink-
slash-Taser. Or this, it's a

combination Taser-slash-Taser. Not :
. date with Halle Berry or Javier

: Bardem. But it might impress Miss
: Linux Kernel 2013 and keep stray

- Luddites from wandering onto

- your lawn.

very imaginative, | know. Sorry, sir,
we're a little underfunded right
now.

Nothing says “l want to be
Daniel Craig or Jennifer Garner”

like accessing your Ubuntu desktop
. from your Android phone, you'll

: need the following:

from your mobile phone. What's
funny is that if Hollywood were
doing it, there would be multiple

Written by Copil Yanez

: cascading menus and screens along
© with some kind of eye-tracking

: digital Heads Up Display and

- virtual keys you'd have to press in :
. the air like a methed-out orchestra :
. composer.

Quick detour: why is it that

© every tinseltown movie shows

. people working with virtual GUIs

: suspended in front of them? I get

- exhausted just lifting my hand to

© turn off the monitor. Forget about
- hacking an enemy server, can you

: imagine typing an email on one of
: those? Are there NO ergonomics :
experts in Hollywood? End detour. :

As usual, Ubuntu's way is easy

and sexy. Not sexy as in actually
: sexy. Accessing your desktop

remotely isn't likely to get you a

To access your Ubuntu desktop

1. An Ubuntu PC (I'm on 13.04) -

. make sure it's connected to your
. home network _
: 2. An Android Phone (I used an HTC :

Droid Incredible Il running

: Gingerbread)

. 3.Someone to shout “Hallelujah!’’
. when you're finished (this is key,
. people, don’t skimp)

Okeedokee, got everything

ready? Good. Go to your PC and
. click on the Ubuntu symbol to

= Desktop Sharing Preferences

Sharing

open the Unity search field. Type
: DESKTOP and you'll see a Desktop
. Sharing application. Click on that

to openiit.

Here is how | configured my

preferences in order to give
. external access to my Ubuntu
. desktop:

The Desktop Sharing window

asks for a password that must be

Allow other users to view your desktop

Allow other users to control your desktop

Security

] You must confirm each access to this machine

Require the user to enter this password: 90000000 |

Automatically configure UPnP router to open and forward ports

Show HNotification Area Icon

) Always

© Onlywhen someone is connected

") Never
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entered in order for someone to
connect from the outside. Use
something you can easily
remember, like the name of the

Khan (Romolo Aquistapace, as if
you didn't know).

You'll notice I left blank the
“You must confirm each access to
this machine” option. You might
want to keep this box checked. It's
never a good idea to leave your
machine accessible to the outside
world, even if you're requiring a

ease of use, but, honestly, do as |
say, not as | do. And, as a general
rule, you should never take

revels in his ignorance.

Oh, if you currently have your
app bar along the left side of your
screen set to auto-hide, change
that to the default so that it's
always visible. If the app bar auto-

hides, it's more difficult to access it

from your phone. Also, if you have
your computer set to sleep after a
certain amount of time, you might

want to change this setting so that

your PC doesn't go to sleep, and
thus disconnect you, in the middle
of a connection.

You'll also need your desktop
PC’s IP address. Ubuntu makes this

. dead simple. Just right-click the
. network icon and click on
gaffer on Star Trek Il: The Wrath of :

Connection Information. Note the

. IP address listed there, you'll need
. itin just a second.

Okay, now it's time to get your

phone ready.

client. That's the software that will

Connection Information

Active Network Connections

Wired connection 1 (default)

General

Interface: Ethernet (eth1)
Hardware Address: 00:50:43:00:B9:E5
Driver: skyz

Speed: 1000 Mb/s
Security: Mone

1Pvd

IP Address: 192.168.1.133
Broadcast Address: 192.168.1.255
Subnet Mask: 255.255,.255.0

Default Rouke: 192.168.1.1

white-haired wizard who captured
this sorcery and gave it away on

the Internet.

| should probably take a

moment to explain what a VNC
. client does. But I'm not gonna.
Life's too short, you know?

The VNC client | used is called

- android-vnc-viewer, and it's free.
: Once you've downloaded the

. Fire up your Android phone and :
- head over to the Google Play

. Store. You're going to need a VNC
password. | have it toggled OFF for :

software, press the icon to run it.

: You'll see a window with empty

: fields. Let's Ffill those in and solldlfy
© your status as Alpha

. connect your phone to your PC. I'm :
: not sure what VNC stands for,

. probably just the initials of the
security advice from someone who :

Nerd/Nerdette among your peers

. (which, if they mainly consist of
villains named Hans with world

VPN Connections

+ Enable Mebworking

Edit Connections...
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domination fetishes, you should

~ consider ditching).

In the Nickname field, type

. something catchy, like Space Wolf
Cor Super Tramp. You're being
. totally badass right now, your
. nickname should reflect this.

Next, type in the password you

. set up on the Desktop Sharing

. application. Finally, type in the

. desktop PC’s IP address. Your

. screen should look something like

that shown on the following page.

Ready? Time to see if your

© Hallelujah shouter is up to the task.
. Also, if there are any annoying

. neighbors who keep trying to

. explain fantasy football to you,

. invite them over. Payback time!
" Connectionnformation B

Click Connect. Hallelujah! Feel

. free to lift your arms up Moses

. style and scream “Behold!” In a few
. moments, your smartphone screen
- will fill with a lower resolution

. version of whatever is on your

. desktop screen. Your phone’s

. screen will now act like a laptop

. trackpad. Wherever you move your
. finger, your cursor follows. Tap the
. screen on an Ubuntu app icon and

. watch it open.
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Pretty cool, right? Good luck and Happy

. Ubuntuing! _ PYTHON SPECIAL EDITIONS:
What can you do with this? The : §

options are endless! You could :
access your PC and email yourself a :
file you forgot to put into the :
cloud. Or click on your webcam and :
do a quick security check of your
home office. Or make people

believe you've just hacked intoa i

bad guy’s world domination E bl
system and are shutting down his Copil is an Aztec name that roughly

nuclear weapons lab with a few :  translates to “you need my heart for

keystrokes. Ladies, you'll be all the what again?” His love of women's

rage at the next LAN party! shoes is chronicled at

: can also watch him embarrass
Go ahead, indulge your inner . himself on Twitter (@copil).

Sydney Bristow or James Bond.

Ml @ 9:28 AM -
— — e PROGRAM T
IN PYTHON T IN PYTHON

Solurme Thnes Volume Four

 androidVNC

SN | ccervesmall:192.168.1.64:5902 —

http://fullcirclemagazine.org/python- http://fullcirclemagazine.org/python-
special-edition-issue-three/ special-edition-volume-four/

Password
v 4 Keep , PROGRAM
INPYTHON IN PYTHON
Volume Five Volume Six
Gl 192.168.1.64 http://fullcirclemagazine.ora/python- http://fullcirclemaqgazine.org/python-
special-edition-volume-five/ special-edition-volume-six/
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LINUX'LAB

ideo is everywhere these

days. Our phones, tablets,
digital cameras and notebooks all
have video capable cameras in
them. Whether you're taking a
family video or producing a

documentary, it's nice to put some

polish on the video. There are a lot
. prompts you to create a new

. project or open an existing project. :

and Kdenlive to name a few. These : If you create a new project, you'll

of video editing tools For Linux:
Lives, Cinelerra, OpenShot, Pitivi,

editing tools will help you put the
polish on your actual video, but
what do you do about creating a
polished looking DVD menu?

In FCM#73, | mentioned
DeVeDe and KMediafactory.
DeVeDe is great for creating
simple menus if you're in a hurry,
but menus look text heavy.
KMediafactory was great at one
time, but it hasn't been developed
in several years and the templates
are limited. Enter DVDStyler.
DVDStyler is a cross-platform free
DVD authoring application for the
creation of professional-looking
DVDs.

DVDStyler is available in the
universe repository of Ubuntu and

Written by Charles McColm

- clelele] T

can be downloaded with a simple

apt—-get install dvdstyler

: DVDStyler has a number of xine '
. video-related dependencies.

When DVDStyler starts, it

. want to adjust some of the project and selecting properties, you can
. title, DVD size, video quality, video :
. format, aspect ratio, and audio

. format for your region. In North

. America we use NTSC. | chose the

. choose your own image and audio
. track for the menu. If you select an :
. audio track, be sure to click the

Erceai]

DvVDSIyler - ihome/chanm dyd.dvds:

Buck Bunny

24127 Mavalis, L] L)

DVD Menus with DVDStyler

16:9 rectangular aspect ratio and
. stuck with the default AC3 audio.

loop check-box to have it play

. more than once (you, too, can have
. that eventually annoying repeating
Next you're shown a number of :
. templates and asked to select a
. template. You can choose a

. template or simple click the no-
. template button. There are a

. selection of backgrounds on the

music track that seems so cool

- when you first hear it).

Once you have your background

. and audio track, it's time to add
. some content. In this instance, |
. left hand side to choose from, but, :
© by right clicking in the blank space

kept it simple and added two

videos by clicking on the File
. Browser tab on the left side and
. dragging two videos to the menu

page. To add text beside the

videos, right-click near the videos,

. select add, then select text, and

. type in the text (Sintel for

. example). Once the text is on the

. page, you can select it and change

. the text properties including font

. size, style, fill, outline color, outline
. size, background color and

. location.

| wanted an option to play both

. videos back-to-back, so I added a

. button from the buttons tab on

. the left. | changed its properties by
. right-clicking on the button,

. selecting properties, then clicking

. on the Play all titles check-box.
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Buttons need not be tied to
videos. You can also add sub-
menus by clicking on the DVD

menu option then clicking add and

menu. This creates a second menu
which you can link a button to by
choosing menu 2 (in the image
above I just have one menu called
Menu 1) from the Jump to drop-
down dialog (instead of title 1 in
the example illustrated). Sub-
menus can be used to create a
menu for chapters, subtitles or
audio.

A good example of how you
might use a second menu is if you
want to provide a menu for
specific chapters of a video. Don’t
worry if your video is one long
video, you can create chapters by
right clicking on the video (title 1

and entering the time for the

second, third, fourth, etc. chapters

in the chapters field.

In the buttons along the left
hand side, there is a square blank
button above an elliptical blank

button. The square button displays

an image once dragged to the
menu space. On the second menu,

drag out enough square buttons to
match the chapters you've created -

(remember chapter 1 usually starts

Properties - Title 1

Video object

Y

AC348kHz . | EN |,

i

NTSC 720x480 o i ...

. at position 0 in the video, so,

- although our screenshot shows 5
. times, we have 6 chapters). Add

. text below or beside each chapter. :
. By default, all the square buttons
- will be linked to chapter 1. To

. change this, right-click on each

: square button, choose properties,
- and from the Jump to drop-down,
select the correct chapter for each the video buttons so they didn't
. button. Don't forget to add a menu :
. button and link it back to menu 1

. (our top/main menu). With a little
. work you can get some neat

. results.

For example), selecting properties, :

Chapters

Chapter 1

Chapter
& f

DVD Styler is a great program,

but, during the making of several
: menus, | bumped into a few

. look correct. Although it's not a

. problem, it would be nice to have
. guidelines in addition to the grid
. option.

Chapter 2

4 Chapter 5 Chapter 6
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When you've imported all your
videos and created all your menus,

. click the File, then click Burn DVD
: and OK to make an ISO image of
your DVD. Use Brasero, XFBurn or
. K3b to burn the ISO to DVD.

If you're feeling particularly

. adventurous, and are not afraid of
. a little XML, you can even create

. problems. First, text appears to be - yourown buttons for DVD Styler. A

. limited to 10 characters. Second,
. although | was able to resize the
. video buttons, the ‘keep aspect

. ratio’ button didn’t work as

. expected and seemed to squish

. guy named Mike created a detailed
. blogger post about how to add

: your own buttons to DVD Styler

. here:

: http://mikesgeneralblog.blogspot.
ca/2006/08/creating-new-buttons-
. for-dvdstyler 04.html

You can find the DVD Styler

documentation and other links on
. the DVD Styler web site at:
. http://www.dvdstyler.org/en/

Happy DVD menuing!

i

=

Charles is a step-father, husband,
and Linux fan, who hosts a not-for-
profit computer refurbishing
project. He maintains a blog at:
http://www.charlesmccolm.com/
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MY STORY

Written by Ketan Patel

I t has been about 6 years since |

of open source. The first open

source operating system that | was
: up connections.

introduced to was OpenSolaris. |
was very eager to know about

Linux and Unix systems when | was
. system more powerful than

© Windows. At that time in India, the :
: word “Linux” was heard by a only

few IT geeks. Linux was used rarely © Ubuntu 10.10 successfully on my

: friend's desktop. We tried to make :

completing my 11th standard in
high school. (In India, graduation
starts after 12th standard.) Until

now, | was mastering in Installation :
: in giant enterprises in India. | tried

loved to fix my friends' systems as | : out OpenSolaris, but I didn't find it :

am crazy about operating systems. : better than Windows.

& Troubleshooting of Windows. |

| love to have a challenge, find

and try new things. | was well
known in my school days and
college days among classmates
and senior students for having IT
skills. In the First year of my
engineering at Government Eng.
college, Dahod, I loved to stay in
the internet lab till it closed. Once
my head of department professor
found out about my IT skills, he
gave me the responsibility to
maintain the system health of all
computer systems in the Internet
lab. As a reward, | got systems for
testing and trying out new things.

At that time, internet connections
took my First dive into the ocean were very limited to a few colleges :
. and enterprise organizations, and

there were slow and unstable dial- anyhow. Internet speed was good

: enough but there weren't stable
- internet connections yet. We could : , . o d:
. hardly download up to 150 MB per : Many questions arose in my mind:

. day. After downloading 5

| was looking for an operating

In September 2009, | came

solutions to problems, fix systems, : across the Ubuntu website while
: Googling about Linux. Ubuntu was :
. different than what | had heard

: about other Linux distros. | found
: Ubuntu more user friendly than

: any other Linux distro—with a nice :
: GUI and powerful security

: features. | began to gather more
. and more information about

: Ubuntu. Due to the slow and

: unstable internet speed (max

: download speed 15 kbps) at that
: time, | could not download Ubuntu :
© 9.10. It would take 3 to 4 days to
. download it, and bandwidth was

also costly at that time.

Around October 2010, when

: Ubuntu 10.10 was launched, | _
- decided to download Ubuntu 10.10 :

: consecutive days with a mobile
. dial-up connection, | downloaded

: a WUBI installation, but Ffailed. |
: decided to install Ubuntu by

© creating a new partition and have a :
: full installation. Finally, I got

: Ubuntu installed within just 20

: This was my first installation of
: Ubuntu. I had seen Ubuntu just in

: explored the whole system. My

: friend was confused about how to
© use the system, but | taught him

: Ubuntu. My friend was very happy
: with Ubuntu because now he had a :
: virus-free system with all required
. software preinstalled. We got

. every device working with Ubuntu
: from a camera to 3G modem

: without installing any additional

drivers. My whole computing world
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changed. | was entering the world
. of Ubuntu.

In November 2010, | assembled

my own desktop with Core i3, 2 GB
: RAM, 500 GB HDD, and Ubuntu.

: How is Ubuntu being developed?

: How do contributors work

: together? What does this

: wonderful system consist of? After
: spending some weeks on the

: Internet, | got my answers. |

: checked out the whole Ubuntu

© history and came across the

¢ Launchpad platform, Ubuntu

. forums, wiki, and Ubuntu

" minutes on a P4 with 512 MB RAM, | documentation. Iwas also
‘ . introduced to other Ubuntu

: derivatives like Backtrack, Linux

. screenshots before. Within 3 days | Mint, and Linux Deepin.

Ubuntu proceeded with 11.04

- Natty, 11.10 Oneric, 12.04 Precise,
© 12.10 Quantal. | have enjoyed

: every Ubuntu distro and never had
: faced a problem during

© installation. For the last two years,
: Ubuntu has grown and improved a
: lot. After the launch of Ubuntu

© 11.10 Natty, many users didn't like
" Unity, but | never faced any
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problem with it. Unity became

stable in 12.04 and fixed problems _

with other users also. | joined

Askubuntu in April 2012 and have a ;| completing my 7th semester exam, :
© | started my journey with Ubuntu
: Server. Within some months | self-
: learned Ubuntu Server. | also got

: command of Red Hat, Fedoraand :
: Centos. Currently | am working as a :

Linux System AdministratorinanIT :

good reputation there.

As a student of Electronics and
Telecommunication Engineering, |
was interested only in the

telecommunication part and have a :
keen knowledge of technologies in :

my field. Now | am interested in
Linux servers as they are a core
part of telecom networks and IT
Enterprises. | decided to learn
about Linux servers and move
towards system administration. |
came across many Linux server
distros like Red Hat, Fedora,
Gentoo, Arch Linux, Centos and
Debian. Most of all | love to work
with Ubuntu Server and Debian.

It took time to learn about
servers due to a busy engineering
schedule. During the time, |
remained connected with the
Ubuntu world using newsletters
and news sites like Omgubuntu

and www.ubuntu-news.net. In time :

| came across FCM. | downloaded
previous issues. After that, every
month | download FCM and never
miss a single issue. | introduced
lots of friends to Ubuntu by
installing on their laptops and

desktops.

In December 2011, after

organization at Surat, Gujarat,

: India. Thus, Ubuntu has played an
: important part in changing my life
. and showed the way to my career.
: The Voyage has been just started, :
: we have to build Cloud Computing :
. platforms within a few months. :
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MY STORY

Written by Andrew Tatton

Acer Aspire One ZG5 for the
relative bargain of £85. It served
me well as a netbook for a couple
of years, | replaced the default
Linux Operating System with

Ubuntu 10.10 Netbook edition and

enjoyed using it. System resources :
. better things were.

were relatively sparse having an
Intel Atom 1.6GHz processor,
512MB RAM and an 8MB Video
card. However, courtesy of severe
butterfingers, | managed to break

the screen. | could have replaced it,

but this would have cost me half of :
. connected via ethernet to the

: adjacent router, and installed

© XBMC 11.0, and selected a few

: plugins for XBMC, the iPlayer

. plugin being of the most interest
: to me. | also installed the Quartz
: skin as | knew that this was a

. lighter skin than the default.

the original purchase price of the
machine, and | had a Dell Latitude
E6400 laptop to use while
travelling, so the netbook simply
got filed away in a drawer for a
few months.

After around 6 months, |
decided to reboot the netbook
using a TV as a monitor, to see

whether it still worked at all, and it

did! I had a spare 1GB memory chip :
: were more polished than others. |

purchased a Microsoft branded
. Wireless keyboard and mouse, and :
. these were simply plug and play, as :

lying around from a previous PC
upgrade, and decided to install
that into the netbook, to see
whether performance improved. It
did, but things still weren't

S everal years ago | purchased an lightning Fast. | had heard about

: XBMC previously, and installed it.
© Even with the extra memory, the
: whole system seemed slow. | was
: aware of Ubuntu derivatives such :
: as Lubuntu, Kubuntu and Xubuntu, :
. the house, and have even used it

. for a barbecue party in my garden.

and decided that | would install
one of them to see hot much

| opted For Lubuntu 12.04,

installing from a USB CD drive as |
¢ has trouble encouraging my

machine to boot from USB stick.
Once Lubuntu was installed, |

The install was flawless, and
before long | was experimenting
with the plugins, some of which

was a USB infra-red remote control

purchased from ebay for £3. This
. little netbook has been quietly

soldiering on in this arrangement
. for the last 6 months. | have set it
© up so that | can now stream audio

and video from a shared drive in

Because of the very limited

hardware of this machine, it would :
: be unrealistic to expect super High :
. Definition at all times, but I can
. stream video from almost any data :
source. Spotify for Linux works :
. without issue. Video is connected :
. via VGA to my television, and audio '
. via phono cable to our surround
sound. If there is ever anything

. that we would like to play that
XBMC cannot handle, we can

: simply launch Chromium and play
via the browser.

On paper, this little netbook

. ought to be almost useless, but,

. for the princely sum of £20, | have
: resurrected this little workhorse,
. and it is now at the centre of my

family's viewing experience.
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Full Circle Podcast
Episode 34,
Raspberry
Jamboree 2013

Your hosts:

 Les Pounder

» Tony Hughes

» Jon Chamberlain \
« Oliver Clark __ u‘l j}
and Freaky Clown 5[ .~
from the Blackpool (UK) LUG
http://blackpool.lug.orqg.uk

Welcome to the first of a 2
part conference special, in
this episode the presenters
reflect on the first ever
Raspberry Jamboree held at
the Manchester Central
Conference Centre on 9th
March 2013
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REVIEW Clementine

Written by Devyn Collier Johnson

lementine is a popular music : quickly when executed, and closes be created and indexed carefully. : Clementine responds to these key-
player for Ubuntu systems. swiftly when closed. Clementine : commands without delay.
This music player makes a great does not require any loading when : Clementine allows users to :
alternative to Rhythmbox and performing many tasks. However, control the player with the The program's layout and
Banshee. Clementine has many Clementine does require some keyboard. For instance, | can press : graphics are set up wonderfully. To
great features and abilities as well time to convert audio files, . F7 tostop the musicand F10 to . the left, users will see their music,
as a nice layout. It is not only a download cover art, rescan music make it louder. This allows users to : Internet radio stations, artist info,
music player but a music manager. : libraries, or lookup tag info. These perform one task without needing : songinfo, and search results -
Clementine allows users to edit : tasks require time because . to switch windows to control . depending on the clicked icon on
tags, create and edit playlists, and converting is a complicated Clementine. Many music players : the far left column. To the right,
convert (transcode) music. © process, networks have limits to like Smplayer, VLC and Mplayer do : users will see the playlist contents.
Clementine can even retrieve cover : . their speed, and the library must i not support this feature. . Clementine displays the different

= e . playlists as tabs. Just as web
trance = : = 3 N . . .
e Qi % Energy ¥ Bxratone ¥ Rado 15 browsers like Firefox permit users
. - S h & & & : H H
¥ Tranceanddance JBs"cp : to have multiple tabs with a
¥ TranceBaseFM - 24hVocal-, Pro Title ; fek
¥ TranceRadio.ch Hard House LUK (HHUE) - Hard House - Hard 8 webpage n eaCh' each playllst .IS d
¥ tranceradiol : tab. At the bottom of the playlist

art and missing tag information.
With Clementine, users have a
choice between using the
application through the app
indicator or as a full window.

H : . L Electronic : H .
Clearly, Qlemenpne is a Fl.ex|ble o T : box, users W’Ill find t.he controls for
and multi-functional music ¥ PulsRadio Version Hard - Hardstyl... : current playing music and the
. ¥ PulsRadio Version Trance - Tranc... :
¢ progress bar. In the bottom left
manager that many Linux us.ers ¥ Vocal Trance - DIGITALLY IMPORT. .. prog . 0 0
may want to try because of its v B House . corner of the application, the
F DISCOID - FrenchWebradio Crea. : cover-art is displaved with the
many Features. ¥ Hard House UK (HHUK) - Hard Ho. .. : L. p. y
» B Other : music title. The icons and buttons
The latest version, at the time ¥ HBR1 -1.D.M. Tranceponder . are carefully placed to provide a

¥ PsyTrancePowerradio : icAai
v M prooressive : compact appearance. This gives

¥ Clubberry Trance . the playlist and library box more

¥ Hirschmilch Psytrance : . .
v B Various . room to list the music Files.

¥ POWER TRAMCE FM4
¥ SanFM.ru=Trance

of writing, is version 1.1.1. This
version is very stable. For example,
Clementine does not crash or
freeze; the program completes

tasks successfully without issues. o LT . Clementine can be used as a tag
In my opinion, Clementine is much ¥ azechnotrance editor. If a user has an mp3 file
more stable than Rhythmbox and ML F—— . that does not have the information

» ® Jamendo " about the artist or genre,
» & Last.fm
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REVIEW - CLEMENTINE

Clementine's tag editor will help.
After a user right-clicks the music
file to be edited, they can click
“Edit track information”. This
causes a window to appear with
two tabs. After clicking the tab
titled “Edit tags”, the user will see
the tags that can be edited. If the
user is unsure about what
information should be typed into
the tags, they can click “Complete
tags automatically” to make

Clementine search the Internet for :
- has another
work only with music made by well :
: makes it a

. powerful

. application:

. converting

- audio.

. Clementine

© can convert

. between a few

. formats. The

: conversion window can

. be opened by clicking

. “Tools” in the menu bar and

. selecting “Transcode Music”. Next,
- click “"Add" to pick music files to
click and select “Append to current :
. The converting feature is very

: convenient and easy to use. For

. example, the converting window
playlist, pick a playlist format and a :

information. This ability would

known musicians and not
individuals that post home-made
music free on the Internet.
Clementine can gather tag
information only if online
databases list the song.

Playlists are easily created and
exported with Clementine. The
first step is to right-click a song in
the left box when “Files” or
“Library” is highlighted. Then,
select “Open in new playlist”. For
the songs that come next, right-

playlist”. After that, right-click the
playlist's tab and click “Save
playlist”. To Finish exporting the

save location. Once chosen, click
“Save”. Clementine makes this

process very easy. Other playlist
creators can be difficult or time-

. consuming to use. Clementine

- allows users to save the playlist in
: numerous formats. Many playlist

- makers do not have a collection of
. choices as large as Clementine's

. list of formats. This allows users to
. easily make a playlist to use with
- any device or music player

. program.

Clementine

feature that

convert and configure the options.

itself is self-explanatory.

Clementine even has a moodbar

and a large variety of color sets. A
moodbar is a colored progress bar

. used instead of the plain default

. progress bar. However, a moodbar
. is not just a colored bar. The colors
. are based on the “mood” of each
. section of the song. The different
color sets are alternate colors used :
: to display each mood. To

. understand what a strip of the

: song is like, it helps to know what
. the color means for the active

: mood color set.

The Internet radio works very
well. Clementine provides
users with a large
selection of radio
stations for any
genre of music.
The collection
is not sparse;
even Icecast
aloneis
extensive.
Clementine has no

. difficulties playing Internet radio
. stations. The sound quality is :
. superb and clear, and the loadingis :
. swift. It seems as if the music is :
: coming from local files.

: Clementine has an extensive list
. of visualizations. They can be
- found and activated by clicking

“Tools > Visualizations”. The
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window that appears contains
options for the visualizations.

Users should be able to find the
. perfect visualization that they

enjoy viewing while listening to

music. The visualizations have a
. clear, sharp appearance. The

moving images are not blocky or

. pixelated.

These many features make

: Clementine a great music manager.
. This is a powerful music player that
: still retains excellent performance.
. This application can satisfy the

. needs and wants of many users

. while still being easy to use. The

. program is pleasing to the eye and

. does not require time to figure out
. the layout. If users decide to try a

. new music manager, or they dislike
: Ubuntu's default music manager,

. Clementine may be a player that

. they may wish to try.
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SOFTWARE SHOWDOWN

Written by Tushar Bhargava

PDE Viewers

I"h this article | want to tell you
about two Linux native, open

provide a consistent way to read
. any kind of paginated documents”.

source PDF viewers that can match

almost all of their Windows
counterparts (and have quirkier
names too!).

THE CONTENDERS

If you use Ubuntu, you must
have come across Evince (below
left)—if not necessarily by that
name. The rather sterile sounding
Document Viewer that Ubuntu
ships with is also known as Evince.
According to Carlos Gracia
Campos, the current project lead,
Evince was,"created by Red Hat to

M music player for
managing their

podcasts. However, gPodder ks a
standalone podoast marager that
might efTer a much betted podor
experience. gRodder |s am Open
Source (GPL Version 3 or higher)
podeast diest made by Thomas
Perl, & Austiian progeammer,

Annatationm » B

REVIEW

Wwirittan by Tuthar Bhargava

List Add

Document containg

o5k peaphe prefer to
use their default

: Document Viewer.”

: counterpart to Evince, however,

: came into being from KPDF—as

. the name suggests a KDE PDF

: viewer. The change of name to

: Okular was both logical and

: pragmatic. When | asked Albert

. Astals Cid, the project lead, about
: the switch, he told me,”"KPDF 'has'
: to be a PDF viewer because of the
: name, while Okular not so; we

. could support more file formats

n

Evince's tagline reads—"Simply a

Okular (below right), KDE's

like we do now.” Indeed, Okular's

separabe ‘Doranlcads’ tab. Yo can
set various imits on the download
spesd and number of simultaneous
deramloads, On clicking the Play’
button gPodder opens your
default music player to play the
podeait. You can choase which
mwedia player gPodder calls in the
Preferences” enbry of the main
merr. gPodder also allows vou
transfer your podcasts to an iPod,

..r\'—

gPodder (001

MTE. File system or blustooth

based device. These options cover ghodder supparts & wide

wariety of formats including RES,
Abpim, YouTube, Sourdcloud,
Vimen and KEPF Feeds. It allows
o b0 add pedcasts from a URL or
to impert tham Froem an OPML Ali
& enables you ko export your own
OPRL Filie which makes & relathoaly
wasy for yous bo shar your podoast
with others or =2t up & podcast
clienl on At hir computer,

virtually all the devioes you fght
e, This feabure, theugh much
|owed by gPodder users, is missing
in version Jx and it is for this
regsan that the wersion in the
Ubuntu Software Center has not
been updated. IF you wank the
device syne Feature stick tothe
older 2.5 varsion

tagline proudly boasts that it is

“More than a reader.”

So, Evince and Okular, though

: part of the same large family that
: is FOSS, are driven by starkly

. different philosophies. However,

. do these philosophies actually

: dictate the development? Or are

. they merely descriptions of the

: team's vision? | decided to fire up

: both and load the same document
: (incidentally a back issue of FCM)

© to find out more.

THE USER INTERFACE

The screenshots below show

the file opened in the two
. different readers.

At first glance, some things are

: evidently clear. Evince—which

. belongs to the GNOME project—is
. perfectly at home in Ubuntu. It has
: Global Menu support and its

: appearance compliments the

: Ambiance theme on my setup. The
: menu bar is simple and intuitive, it
: includes up and down arrows for

© pavigating the document. The

: current page number and total

: number of pages are also

: shown—they help you get your

: bearings and are useful in large
documents. The other important

4 Previow ¥ Meat Fit width @ | = +, Doszem Owlt o, Doszam in

! meowse i Zoom |7 Selection.

REVIEW

WrEine by Tarhar Bhargers

o5t people prefer te

Thumbnalls
ube their defaul
sk playes for

maragng e

ks | asmwsnr, gPodder g
dwlane padoeat mansger bhat
b effar a much batter padeast
srisrecs. gPedder is as Dpan

o (CFL Wiersien 3 o¢ highe]
ekt liont made by Thamas
LA AUSITRNE [0 g 3T T
drder ww created in 2005 with

SpEed

gPodder was created in 2005 with — = medest aim of tewnisading :‘uh e e
the modest sim of downloading Despite ks simple and easy to - 7 | managing podoasts. It s < @ we ingestace n:q:ﬂgr hasi r:;.,.-
#nd managing podcasts. It was < a use inberface gPodder has its Fair b= fer wrikben In Jawa using the
Aarliar warithem In s using the share of advanged Neatures that 1 Ul Bt s slace b poreed un (]| S0 ¥ | Besnken Hote DA ATV P
Gtk U but has since been ported to can be Found under the s = won. B osrrenkly use the Pycik ‘.:.T:.. wiE e e Brbsaird Tushar Bhargava

Pythaon. |t currently uses the PyCek E""*"*m uﬂ Ty ‘MI - i aind w Preferences entryin the . okt Ul which giees & 4 nice T fellarrle ikl Truneiey My first FCM Artiche |

andl GHCZ LI which gives it 3 nica — " o Therua Podcasts” menu, gPodder alows & it lock asd 1.-||.r.|ub.|r;\.-uu gl | e | 1 i i

Ubunbu look and feel. Global Menu || B8 20 s, ] L e re— ou o set an ‘update interal to :z"i‘-:l:“ "ili l:ﬂil perhect o

suppert giers it an almast perfect refceds. GE an ol check for new podcasts. It allows E— = | rratn Bow e o Ty

Uiunt integration. Hewever, [ s 141 40 Tumiay youltoset nits onithe nusber of 1 = ¥ nteg L 851 P 2 e 205

Uiy inkagration ks still migsing kel BT AL i Fridey e 112 mﬁ!::rpn;::ﬁﬁ:ri:;?f::rzl . S0 ha grapaical user interface is S ——

- uemple and nbitive. The mais

_ The graphical user interface is bae B PEESM- i fride e e & new episode i Found. in additian i v il at  uick S —

simple andstultive, The man g e L oy o | I —— to this, gPodder allows you bo set glancs. gPeddar affis yeu thi B0 iy 7 s 2507

Features are visibbe at a quick e Corwtn e e yeur own nidas for ‘caan-up P options to deowsload, play o e e —

ilinse 0P offers v the B e ~ Solfric Al 1y pem Fride 39 s oy i transler sis podrasts When e | P, el B

separabe Tiowaloads tab. You can
s#L variow Brts on the dowsload
and number of smukanegus
deswnleads. On clicking the ‘Play’
bettan gPodder apess pour
default music player be play the
pedeant. You can cheass mhich
madia player gPodser calls is the
Praferinces’ antry of tha main
marva. QPodder alee allews pea
ransler poer pooLasts 1o a8 Fod,

gPodder (88Y

FPotdeT SeppOIts & wilk
wariety of farmats induding RSS,
Aram. YouTule, Seurdeloud,
Wimea and N5PF Fredy it slows
#6410 a0 padcasts from g URL o
to imgart them Fram an OFML fily
& enables yau Eo saport your gwn|
oML file which ki it oelative
aany Far you bo share yaur padeaal
with otheds o 56t up a podsas
CREAL an S0 LRET Dem paLer,

WTP, file sysbem or bluetonth
based dirsice. These DBLINS DOvEr
wirtwally a1l bhe devioes yau might
wam, This Feature, thaugh muck
laved by gPodder s, iy minsisg
in wersian Xu ard & is for this
rmason thak the seesien in tha
Ubustu Saftware Center has nol
it updatud. If you want the
device spnd Peature stk te the

el 2.8 e s

full circle magazine #74 @ 36

n contents ©


http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp

SOFTWARE SHOWDOWN

option included is the “Zoom”
percentage. “Fit Page Width"” and
“Best Fit" are handy options that
save you the effort of estimating
the right percentage. The menu
bar also has an option to show the
parent folder to which the
document belongs, which can be
surprisingly useful for certain use
cases (eg: browsing the FCM
archive on my hard drive).

first column is extremely
unobtrusive and the focus is
clearly on the
document—extremely clever
design. The first column though

the bookmarks and annotations
(you have to select these from a
drop-down menu).

Now to Okular. A perfunctory
glance at the screenshot and you
would think that Okular acquits
itself well in strange waters (it's
part of the KDE project,
remember). Sure, the Ul isn't as
elegant or as simple as Evince's Ul,
but it's still fairly straightforward.
The navigation bar has the
standard “previous” and “next”
buttons, a small difference from
Evince—they're horizontal. And

that tiny detail makes a significant
difference, somehow browsing

. doesn't seem as intuitive as it did
. on Evince. The rest of the items on :
: the navigation bar more or less :
: match Evince's. There's a “Zoom”
. option with “Fit width” and “Fit :
. page.” An added advantage are the :
. simple “Zoom in” and “Zoom out” :
: buttons that allow you to

: circumvent the percentage

- dilemma and simply go on clicking
Evince has a two-column Ul, the :
: “Browse” button that doesn't do
: much in particular. There's also a
. “Selection” tool that is simply

. awesome. But more about that

. later, let me first complete the Ul
serves an important purpose other :
than just thumbnails, it also shows :

till you're comfortable. There's a

description.

Okular's Ul can be referred to

: as a three-column interface. The
. first column has four

: buttons—"Contents,”

: “Thumbnails,
. “Bookmarks.” Choosing one of the :
. four determines the contents of

. the next column, which, uhh,

. shows the thumbnails, bookmarks
: or annotations. The final column

. shows the document, again it's

. larger than the other two but

. perhaps places slightly less

. emphasis on the document than

" Evince. Having said that, the three- °

n u

Reviews"” and

column view has its advantages—it

makes accessing annotations and
bookmarks much easier, avoiding

. the drop-down complication of

Evince.

. PERFORMANCE

Just as we shouldn't judge a

. PDF by its cover page (sorry but |
. love bringing familiar sayings to

. the 21st Century), we can't be

. satisfied merely by analyzing the
© GUI of both Evince and Okular. The
. question is how do they perform

- with a large, picture-filled PDF file
. like an FCM edition? But, before |

. answer that question, a short

. detour.
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| loaded FCM, edition #63. |
then started browsing rapidly.

. Evince didn't much care for my

. style of reading, after a few pages

. it would show blank pages and

. display a rather apologetic looking
. yellow loading sign, accompanied

. by a spinning progress wheel. The

. delay was only a few seconds, but

. irritating nonetheless. In sharp

. contrast, Okular on opening the

. PDF informed me in a business-like
. gray message box that it had

. loaded the 59 page document. And
- it really had. I could browse

. through as fast as | wanted. The

. searches in Okular were sniper like,
. Google-esque—super accurate and
. super fast. It managed to find my

Okular, under “Settings,” has an name in the magazine (sorry for

. option called “Configure Okular.”
. And under that there is a :
. “Performance” tab. And in that tab :
. lies Okular's hidden (literally)

. ace—memory usage modes. You

. ego surfing) literally within
. seconds.

ANNOTATIONS AND OTHER
Ty us: _ : GOODIES

. can choose “low” memory usage if

. your machine is slow, “Normal”is :
. the default. But if your computer is :

b : from here. PDFs are quickly
: fairly modern and has RAM greater :

: - - replacing books and traditional
© than 512 MB, choose “Aggressive.” :
. Congratulations, you now have a
. PDF reader on steroids. In the

- comparison that follows my Okular :

. was in “Aggressive” mode.

Things go downbhill for Evince

. paper documents; you want to be

. able to make annotations on them.
. Evince scored very poorly in this

: category. The only annotation

. possible is adding a small note.

And in case you typed that note
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SOFTWARE SHOWDOWN

wrong, you can't delete it. Yes you

heard me right, Evince informs you

that it can't delete annotations as
of now. In a nutshell, it is simply a
document viewer.

Okular, on the other hand,
really is more than a reader. Its
annotation tools prove that its

plethora of icons shows up on the
left-hand side of the document.
Each icon depicts an annotation
operation. You can make a note,
make an in-line note, draw
freehand, highlight, make ellipses
and rectangles, and even put a
stamp (Okular logo with your
name) on the document. Further,
the “Selection” tool in the
navigation bar makes selecting
text or images a snap. After you

select them, you can either copy to

the clipboard or directly save them :
P Y - 'bad attitude' comes from user(s)

. than from developers.” While Mr.  :
. Campos pointed out that advanced :
: annotations may be lacking in :
. Evince as of now, but only because :
. of “lack of manpower” and to
. remember, “that all Evince

. contributors are volunteers.”

in a file. It works flawlessly and is
one of the most efficient ways of
extracting data from a PDF that |
have seen so far.

Both document viewers had a
“Presentation” mode that would
certainly come in handy, Evince's
offering was again a tad better
designed.

CONCLUSION

In the end however, there can

. only be one default PDF viewer.

: And that is Okular! Despite

. Evince's better, slicker Ul, Okular's
. superior feature list and blazingly
: fast “Aggressive mode” makes it

. the PDF viewer of choice for FOSS

boast was not an empty one. Press : fFans.

F6 or “Review” under “Tools,” and a :

. HOWEVER..

Mr. Cid told me, “Most of the

Whichever document viewer

of effort goes into developing and
maintaining both Evince and

. Okular. More importantly, both

. belong to the FOSS family and

. deserve appreciation—no matter
. what their shortcomings. Show

. your gratitude by dropping them
. an email (or even better, offering
: to contribute) at okular-

. devel@kde.org (Okular) and

. evince-list@gnome.org (Evince).

. SUMMARY — EVINCE

: Having said that, | would like to :
. put forward a small addendum. :
. While interviewing the project

. leads of both Evince and Okular, |
. realized that the projects share a
. close relationship. In fact they

. both work together on “poppler”
. the PDF rendering library that

. powers both viewers.

: -1 -1 -1 -1 [
The Good

.« Intuitive, simple and elegant user :
. interface

* A great professional looking
. Presentation mode

. » A great guide to using Evince
. under 'Help' > 'Contents'

. The Bad

.« Lackluster performance with
. large PDF files

 Lack of annotation features and

. the inability to delete a simple

note

. +Issues while selecting text, which :
. the guide itself describes as a hit
. and trial procedure

. Website - :
. http://projects.gnome.org/evince/ :
you choose, don't forget that a lot
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SUMMARY — OKULAR

L, | L, | L, | L, | L]

. The Good

. « Efficient and fast performance

. especially on a large PDF file

.« Amazing annotation options

.« Great text or image selection

. tool, in Fact the best I've ever seen
: onany OS

.« Extremely powerful searches

. especially in the 'Aggressive’' mode
.« The option to choose memory

' management modes makes it

. adaptable to computers of all

. types

. The Bad

© « A bit clunky User Interface

.« Sometimes the menu options

: don't work

: « May take up a lot of memory on
. GNOME environments as it needs
. the KDE dependencies

. Website - http://okular.kde.ora/

The Winner is: Okular!

=

Tushar is a 17-year-old Indian who
loves Ubuntu/FOSS. He programs in
Java and C++, enjoys writing, and
making Android apps. Email him at

'Software Showdown' in the subject.
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#!/bin/bash

O LETTERS

If you would like to submit a letter For publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.

PLEASE NOTE: some letters may be edited for space.

echo -n "What is the issue number of the first Full Circle Magazine to download? "

read firstissue

echo ww

echo —-n "What is the issue number of the last Full Circle Magazine to download? (> or =

the previous number) "
read lastissue

cd ~/Downloads/fullcircle

there I wanted to use my folder 'Desktop'

for a in “seq $firstissue $lastissue’

do

# ~ brings you to the home directory of the user and from

wget -U Mozilla "http://dl.fullcirclemagazine.org/issue"$a"_en.pdf"

done

echo nmw
echo "Complete!"

DOWNLOAD SCRIPT
ne way for people to

have the downloader script on

their computers. They can use that

to download any issue(s) directly.
I'm doing this right now.

Listed above is the text of the

Something to note about this
script. It will download it to the
current directory--regardless of
the cd command in the script. At

least that was my experience. And
: the user will have to change the
: translation code (en) to whatever

. is relevant (if available).
download Full Circle is if they :

Patrick. Dickey

script, in case people don't have it. PYQT

I really liked the Qt Designer :
- I tutorial in FCM#73. | have a good :
. command over Python, C++and

Java, but I really don't know much

: about creating GUIs. | know you've
: covered wxPython and Boa :
: Constructor, but I'd really

. appreciate it if someone does a

: dedicated tutorial series on PyQt
. oron Qtin general.

Rohan Pinto

Ronnie says: It might take a few
: months, but Greg is going to look
: into it for you.
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Join us on:

000.gl/FRTMI

4 facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

m linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

P — ———————————— — ——— ————

FuLL CircLE NEEDS You!
A Without reader input
&5 Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop

See the article Writing for Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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LETTERS

LIBREOFFICE STYLING

Greg & Elmer say
~ gedit by hand.

have been using Ubuntu for the :

last 3 years and | wouldn't
change it for anything else. Full
Circle Magazine is a great
magazine to supplement what is
new in Ubuntu.

My job requires me to produce
specialist manuals and the styling

paragraph titles is most important

to be able to refer. Just as an
example, it would be something
like this

RPRRR
PRrRO

1
1.1

with different font styles and
font sizes. The problem is that |
cannot find a way to save this set
of styles in LibreOffice to be re-
used consistently throughout
various manuals.

While we are in the same
subject would you please
recommend an XML editor that
uses DITA in Ubuntu linux
environment?

Christian Gauci

: For XML, | use

Elmer says: Saving the style to
the default template seems like the

. way to go, but have never tried it.

The answer may be a template but
not the default template. | will look

into it.

l

Joana, dear...?
Still awake?
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QZA

If you have Ubuntu-related questions, email them to:

questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

| recently installed Ubuntu on :
: performance by installing an

© "additional driver," which is done
© via the Ubuntu Software Centre.

Q my system, which has an Asus
M5A99x Evo motherboard, and |
can't figure out how to get the
drivers to work. I'm new to Linux.

A Drivers work very differently
in Linux than what you are
used to. Most drivers are included
with the kernel, so it "just works."
If you have installed Linux and
everything works, you have no
need to chase after drivers.

as well as 13.04. Even with 13.04,
it's possible some bits won't work,
such as the Ethernet port.

Wireless adapters are a special

case, some just work, some work if :

you say the appropriate "shazaam," :
: version of Skype doesn't play nice.

some work after quite a struggle,
and some never work. Webcams
and printers are similar.

My entire system "just works,"
including all of the above, also a

scanner.

Video cards usually just work,

Compiled by Gord Campbell

but then you can get better

in the Ubuntu Forums) Right-

click on the desktop. Select

Since your motherboard is very

new, older versions might not work '
. the upper-left one has a white

. clock drawn on it. That is the
. background slide-show.

"Change Desktop Background." A
group of thumbnails will appear,

Machine is a FitPc3, running
Ubuntu 64-bit 12.04. The new

A Install multiarch-support.

I'm trying to use WiFiin a
hospital, but the connection
drops every few minutes. | can

reconnect, but then it drops again.

(Thanks to praseodym and
steeldriver in the Ubuntu

they have multiple access points

: sharing the same ESSID. That can
. make the wireless device go crazy
© trying to roam to the nearest /

: : strongest access point. Run this
A (Thanks to Maverick Meerkat :

command: sudo iwlist scan

Add the MAC-address of the

© nearest access point into the field
: "BSSID" in the network-manager

. applet. (You'll need to change it if
© you move to a different location in
: the hospital.) :

My Ubuntu Server works

: great, and now | need to make P ¢
: aLivecd in order to copy the server : e S R R SEE e
: to some other machines with the

: same hardware.

A (Thanks to Shrek01in the

Ubuntu Forums) Hi, have you

met Clonezilla?
: http://clonezilla.org/
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| have a multi-boot PC. When |

Q installed a new version of
¢ Linux to play with, it became the

: i _ i grub default. How can I change
: Forums) Sometimes the problem in :

© 'campus' type networks is that
: Q In Ubuntu 13.04, how can | get :
the background to change
. every few minutes, so the
: wallpaper becomes a slideshow?

this?

Boot into the version of Linux
you want as your default, then

© issue this command:

! sudo grub-install /dev/sda

In Ubuntu 13.04, my wireless
doesn't work: Broadcom

Corporation BCM4313 802.11b/g/n
: Wireless LAN Controller (rev 01)

(Thanks to chili555in the
Ubuntu Forums) Enter these

: commands:

sudo apt—get remove —-—-purge

sudo apt—-get install linux-
: firmware—nonfree

Then reboot.
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Q&A

| want to be able to rename
multiple Files?

A Install gprename.

FrROM THE UBUNTU NEWS
DIGEST, ACTIVE AND TOP
QUESTIONS AT ASKUBUNTU:

* |s there a way to restore
Nautilus' split screen (F3) feature?
http://g00.9l/NOzhg

* Dependency error while
installing Google Chrome on
Ubuntu 13.04
http://900.9l/VQGMA

* Why is the life of Ubuntu 13.04
so short?
http://goo.gl/ceaPM

* Did | just delete everything with
find -exec mv?
http://goo.ql/T7(To

* Jupiter or similar power saving
app for 13.04?
http://qo0.gl/zy4JE

* Does encrypting the hard drive

: Insync, and others?
. http://askubuntu.com/questions/2

. 95349/

* How do you get an hourly talking
: clock for Ubuntu 12.04?
. http://askubuntu.com/questions/2

. 95792/

* How do | set Facebook, Twitter
: and GMail accounts in the Ubuntu
: 13.04 online accounts?

affect file sync with programs like  http://askubuntu.com/questions/2

http://go0.gl/0kgGe

Dropbox, Ubuntu One, Spider Oak, _ 96455/

. * Backspace in insert mode in vi
: doesn't erase the character

; 96385/

* Remotely turning on computer?
. http://askubuntu.com/questions/2

. * Desktop shows a white or black
. background instead of wallpapers
: http://qo0.ql/JmI6i

. http://askubuntu.com/questions/2 ‘:

: *Where can | look for malware

: that may have been installed on

: my machine?

: http://askubuntu.com/questions/2

§ 97198/

* Update available message after
installing update

: 98992

: *How do | obtain and install larger
: mouse pointers - 1 am slightly

T+ G 4 W Q 100% ® |icon View vl Q
Places *+ % 41 || fif sahni| | Videos | music videos 1 fifsahni

|} sahni
) = i et et et -
— File 5?51‘.3]1‘] backup bin hﬂck‘l.lp bin
;| liE Network
| d e d e
k2 Data laJ
= Trash Calibre Library chia Calibre Library chia
[ article - =
: |l music videos J a
i Downloads Desktop desktop items Desktop desktop items
@ Classified on the b...
;[ I dwhelper "R il B il
s new_levell Documents Downloads Documents Downloads

[ sem8

| - | = |
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Q&A

visually impaired
http://askubuntu.com/questions/2

standalone session?

98842

* Does it make sense to create
swap partitions for new
installations nowadays?

http://askubuntu.com/questions/2

- TiPs AND TECHNIQUES

. Server? Really?
* How do | switch between English : y

99417

and Greek Polytonic?

http://askubuntu.com/questions/2

98708

* How to use wildcards for string
conditionals using bash?

http://askubuntu.com/questions/2 do everything From the command

- line, and some things are just a lot

- easier if you have a graphical
* Run same command again but as Y arap

99710

sudo
http://goo.gl/nyMik

* How to sandbox applications?
http://qoo.gl/YHz8r

* Does the Ubuntu 13.04 disk
image fit on a CD?
http://goo.gl/6LLbD

* How to post reviews on
apps.ubuntu.com?
http://q00.9l/GStZj

* Can |l run Steam as its own

http://goo.gl/xbUijt

* Computer running very slowly

. under 13.04
. http://goo.ql/TM2Xt

110

Imost from the beginning,

Only one problem: you need to

non-administrative activitles.

Full name for the new user:

<G00 Back:

1 [1!] Set up users and passwords |

A user account will be created for you to use Instead of the root account for

Flease enter the real name of this user. This information will be used for instance as
default origin for emails sent by this user as well as any program which displays or uses
the user's real name. Your full name is a reasonable cholce.

interface. So what does the Server

version buy you?

For starters, it needs less

. memory than the Desktop version.
. It also runs faster, and that's

. important if you are running a

. high-volume website or a busy

. database server. Those needs

. sound pretty corporate; if you're

. installing a server in your house,

. it's unlikely that you will need that

people have had the option of little bit of performance.

 installing Ubuntu Server rather
. than Desktop.

The cost of a server computer

. which can run a GUI is minimal.

. Where | live, there are computer

. stores which sell off-lease

. computers. For example, a system
. with an Intel Core 2 Duo, 2 GB of

. memory and a small hard drive

<Cont inuex
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goes for $130 -- and it will run
Xubuntu like gang busters. For a

. household server, you will

. probably want lots of disk space,
. so you'll replace the hard drive

: with a 2 TB model: $95 gets you a
. pretty decent one. We're up to

: $225, which is pretty cheap as

. computers go.

Running Xubuntu, most of the

. system tools you are used to are

. right there; you don't need to use
. Google every time you want to do
. something. You can install

. everything which might be part of
. aserver system, and it all works.

. Website? Check. Sharing Files?

: Piece of cake. Media server? Yup.

. Databases? No problem. Well, no

. more than you would expect with
. databases.

And yet, | still see questions

which begin, "I'm running Ubuntu
. Server, version ..." And | wonder
- why.

;E|

After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.
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Emma Marshall: Can you tell us
a little bit about yourself?

Diane Leikvold (above): | am
the network administrator,
desktop support, and technology
coordinator at Longmont Christian

School in Longmont, Colorado. |
also teach keyboarding to 4th and
5th graders, and Google Docs to
middle school students and
teachers. My hobbies are biking,

Zumba, camping, being outdoors in
the sun. I have been married for 24 :

wonderful years to my husband
Kurt, and we have 2 grown boys.

EM: How did you discover

UBUNTU WOMEN

Written by The Ubuntu Women Team

Ubuntu?

_ DL: My husband introduced me
: to Ubuntu in the summer of 2010.

: Our school was still using Windows :
:  telling them about Ubuntu and

: how successful it is at our school. |
sent an Ubuntu laptop home with
. them so they could play with the
operating system and see if it

: would work in their schools. After
. introducing them to Ubuntu, they
¢ continue to use it in their
missionary schools there locally. |
¢ continue to send more laptops

. with Ubuntu to them as they

: become available through

. donations.

: 2000 due to budget constraints.

: Since Windows 2000 was losing
support that summer, we were

: looking for a replacement. My

. husband showed me Ubuntu

: during our camping trip to South

© Padre Island, and | fell in love with
: the operating system, so we made
: the decision to convert the whole
. school that summer.

: EM: How do you use Ubuntu in
: your daily routine? Work or
: recreational or both?

DL: Both. After | converted the
. school, we also converted our

: home. | use Ubuntu exclusively in
: our home.

At school, | have approx 120
: Ubuntu. | have two labs, and the
. rest are teacher and classroom

: machines.

| have also donated laptop

laptop/desktop computers running :
. application software in the high

: school at Longmont Christian

: School in 2000 with 12 computers
: throughout the school (nine being

: computers installed with Ubuntu
to missionaries in Kenya. There

: were a couple of missionaries who
came to the U.S. for a visit at our

church. I spent a whole dinner

EM: You recently shared your

: success about the Longmont

: Christian School transition to

: Ubuntu with the Colorado Ubuntu
: Team, can you share your success
with the community?

DL: | started teaching

in my lab) with a dial-up
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. connection. The next year, we

. networked the school and doubled
. the amount of computers. By 2009
we were up to 63 computers

: running Windows 2000. In 2010, |

: wrote a proposal and presented

. our desire to change to Ubuntu to
: the principal of the school. After

: gaining his approval, | imaged all of
: the computers in the school with

: Ubuntu 10.04, wrote training

: material for the teachers, and sent
. an email out to notify the teachers
. of the upcoming changes and

: training dates. The week before

: school started, | trained all of the

. teachers and staff on Ubuntu and

: boldly started the year on the new
. platform.

| was truly amazed at how

: smoothly it went for such a large

. change. The teachers embraced

. the new operating system and

: continue to enjoy using it today.

: Through the years, | brought what |
. was teaching in the high school

: down to middle school and then

. elementary. | truly believe that

: what we have at Longmont

. Christian School is pretty

awesome!
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| have 26 teachers, most were

technology challenged and fearful,

but they all love using Ubuntu and
are doing so well. | have over 120
laptops/desktops dispersed

with Ubuntu. I would love to get
the word out to Canonical and

Boulder County to spread the word

even farther on how Ubuntu is a
great solution.

EM: What influenced you to
take on such a large project?
What's the most rewarding aspect
of the Longmont Christian School
project?

DL: The school was using
Windows 2000 and the support
was up in the summer of 2010. We
needed to upgrade our operating
system, but the school was very
budget constrained, so, with my
husband’s encouragement, we
looked into Ubuntu. The rest is
history.

The most rewarding aspect for
me is how smooth the transition
happened at our school and how
easily the teachers adopted the
new operating system. | am even

able to support teacher curriculum

through Wine in Ubuntu.

EM: If you could influence every
school in the country to transition

DL: It is easy to use and

. maintain. | have found that my :
support hours were reduced once | :
. switched the school from Windows
. to Ubuntu. It is very well packaged
and is pretty easy to maintain.

If | could have a #2, the second

'_'b
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would be cost. | use donated
hardware with a zero cost

. their computer labs to run Ubuntu, : operating system and zero cost

. what would be your #1 reason to
: convince them?
throughout the school all installed

. software. For a small, private

. school, this goes a long way to

. reduce overall cost of the school
. and helps lower tuition for the

. parents.

EM: What do you hope to
achieve in the future in your

. efforts to promote Ubuntu?

DL: This summer | am planning

on providing free training in

~ Ubuntu for our parents.

EM: What other Ubuntu

projects/groups are you involved
: with?

DL: I supported the Ubuntu lab

. ataTIE (Technology in Education)

. conference in 2011. | recently

. became involved with the Colorado
. Ubuntu Users Group as well.

For people looking to get

. involved in Ubuntu, who aren't

. interested in learning how to code,
. what advice can you give to help

. them get started?

My advice is to share their

Ubuntu successes with people
. around them—to help spread
. Ubuntu to a larger community.

EM: Is there anything else you'd

like to add?

DL: Once | started using

Ubuntuy, | fellin love with it. It is my
. desire to continue to work with
. and to promote Ubuntu.
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Written by Joseph Johaneman

G ratuitous Space Battles is a
space-based RTS made by
Positech Games. It is unusual in
that there is no resource
exploitation, and, once ships are
issued orders, the player has no
control over the outcome of the
battle. This sounds like a simple
concept, but, in execution, the
game is phenomenally difficult at
times.

Players can create their own
ships from the ground up. There
are pre-built ship designs if you
want to use them, but it behooves
you to learn how the ship design
mechanism works. Every empty

hull is a blank slate that allows you 1.

to create ships as fast or as
powerful as you think you'll need.

Each battle starts simply: you
are given a certain amount of
resources and pilots, and can
create a fleet within those

guidelines. Your opponent also has

the same limitations. Once you lay
out your fleet and give orders, you
press the fight button and the
fleet is deployed.

You can watch the battle take

place, but you can't intervene. It's
- incredibly fun to watch your ships
. follow their orders, and the 2D

. graphics are incredibly well done.
. At the top of the screenis a

. communications panel which

- displays messages about the battle :
: from the point of view of the

. pilots. Sometimes these messages
. are humorous, and it's worth

. looking up to see what's being

- said. If you're impatient, you can

. speed the battle up to 4 times the
: normal speed.

Each battle is different, and it'll

: S
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Gratuitous Space Battles

: take a lot of trial-and-error before
. you figure out exactly how to

. design and deploy a fleet in order
: to emerge victorious. For each :
: victory, you win honor points which :
: can be used to unlock components :
: and new playable races. You can

replay battles and win even more

: honor by using fewer ships and
. pilots.

This game is not for the casual

: game player. It requires a lot of

. thought and planning in order to
: win each battle, especially as the
: game advances. Gratuitous Space
: Battles is certainly not for

. everyone. If you're a fan of

: strategy games, though, you

. should definitely check it out. My
. only complaint about the game is

the repetitiveness. After you
master ship design, the game

. becomes easier and easier.

Currently, the Linux version is

: available from Steam and Desura

: for $14.99. Unfortunately, none of
: the downloadable content (DLC) is
: available for Linux. (The Positech

: Forums do have discussions on

. how to make the DLC work in

: Linux. Your mileage may vary).

: Pros:

. Great 2D graphics, fun battles,
. decent background music.

: Cons:

: Repetitive Game Play

(a=)

Joseph is a Comms major at Keystone
College and is the Director of
Technology for Gamers Against
Bigotry. You can follow Joe on twitter
(@dogboi) and find his blog at
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as | think is also the case in a lot
of countries, | need to make a
number of job applications a

month. Now, I'm also the organised

type and | like to keep all my
applications nicely foldered away

have a folder hierarchy as follows:

unemployed —-> applications
——> jan, feb, may (it's been
some time now) —-> job_name

Now, of course, when I login, |
arrive in the home directory, and
because of my meticulous folder
architecture :), it takes some time
to navigate to the said month or
even application upon which I'm
working. In the window (point &
click), I have set up a shortcut, but
as | like to use the terminal, I'd like
to set up a link in my home
directory which will jump to the
month where all my current
applications are stored. Now how
do I do that? With a symlink.

WHAT ARE SYMLINKS?

Basically, a symlink is a file

! Possibility 1:
: file link

: Possibility 2:
! files directory

LINUX CERTIFIED

Written by Richard Philip Witt
'm unemployed, and where | live, ; which points to another file.

. THE CODE

So we know | need one. We

know what it is, well in theory at
. : : : least. Now how do | create one? In

: possibilities:

ln [options]

ln [options]

The first noteworthy item is

© that setting a symlink isn't a :
: default option for the In command. :
© You need to pass -s to the [options] :
: section, otherwise you'll createa
: hard link.

Now to create the link to the

: application I'm working on.

: Presently it's May and all my

: applications are in my May folder
: (some of my desktop is organised
© in German so it's written Mai). Also
© | want to create a link to a folder,
: not a file. My first attempt.

" Navigate to where | want to place

the link (in my case in my

Documents folder), and type:

: 1n -s
: /home/rpwitt/Documents/unempl :
: oyed/applications/NPAB_Mai/
: new_link

To repeat, '/home/rpwitt/...." is

: the location to which I want the

: symlink to jump to, and the name

. of the link is 'new_link'. Now if I cd
. orls 'new_link', I get the contents
. of my NPAB_Mai directory.

. EDITING SYMLINKS

Now | only used the name

: 'new_link' For demonstrative :
purposes and also it's not going to :

be May for ever. At some point, in

. the not too distant future, I'm :
: going to be sending applications in :
. another month. So I need to be :
. able to change the name of my

. symlink, and also the location to

: which it points. First, change the

. name. This is as simple as one

: would imagine it might be. Simply
: change the symlink name as you

: might a filename:

 mv new_link may_ app
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Now | would like to change the

. location to which the link points.
¢ Just repeat the code above, but
: pointing to a new location:

1n -s

! /home/rpwitt/Documents/unempl
: oyed/applications/NPAB_Jun/

: jun_app

Anyway, | hope that helped, and

© if you are a seasoned symlinker or
: have just put together your first,

. like me, please write to let me

: know your ideas. | would love to

: hear about how you use symlinks.

(a=)

Richard Philip Witt, 30, living in
Switzerland. I've been using Ubuntu
desktop and server for roughly 2
years. But only for the basics. Now |
want to discover its capabilities. Any
mentors out there? Email me:
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MY DESKTOP

Pulpit Ubuntw
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My netbook:
Model - ASUS Eee PC 1001 PXD

BIOS Revision - 0601 02/18/11

Operating System - Windows 7 and Ubuntu 13.04 (default)
Desktop Environment - Unity

Processor - Intel Atom CPU N455 @ 1.66GHz x 2 (32-bit)
Graphics - Intel IGD

Memory - 2 GB

Hard Disc - 250 GB

Leon Miklosik

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

= OB 50 EERS M, B
| use Linux Mint 13 "Maya" Cinnamon (32 bits). | moved my task
bar at the bottom to the top! About the girlin the background,
her name is "Faith" and she is the heroine of the game "Mirror's
Edge" (Link to download the background image :
http://www.jeuxvideo.com/downloads/fonds-ecrans-
wallpaper/images/0001/19294-976-mirror-s-edge-pc-fond-ecrans-
4028.htm)

At the bottom of the screen, | use Avant-Windows-Navigator with
all my favorite applications.

My equipment:

Motherboard: ASUS A8V VM-SE, CPU: AMD Athlon 64 3500+ (2.20
GHz), OS: Linux Mint 13 "Maya" Cinnamon (i386), RAM: 1 GB,
Graphics Card: ATI Radeon HD 4600

Khalif ADAM
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MY DESKTOP

= @ sewchar enie asees

That’s all Folks. I'm all out of My Desktop screens. If
anyone wants to submit their desktop, feel free to
email a screenshot (but no wider than 900 pixels, and
in JPG format) with the appropriate information to:
misc@fullcirclemagazine.org. Thanks!

| have been using Ubuntu since 2008.

At the moment | use Ubuntu 12.04 LTS with Ghome Shell : . , _
3.4. I modified the stock GUI because | think it is not If you Sent_ a desktop scrgen angl |t'hasn t a.ppeared in
practical enough. | used only official Gnome Shell : FCM then it means you either didn’t submit

Extensions (available in https://extensions.gnome.org/). any/enough information, elrSfetilr screenshot was too
: large. Feel free to resubmit.

My hardware:

Lenovo R400,

Processor: Intel® Core™2 Duo CPU P8600 @ 2.40GHz x 2
Graphics: Integrated Intel, Intel Graphics Media
Accelerator (GMA) 4500MHD

Memory: 4 GB

HDD: 160 GB

Display: 1280 x 800

Karoly Nagy
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- FCM#75
A magazine isn't a magazine without articles and Full Circle is no Sunday 07th July 2013.
exception. We need your opinions, desktops, stories, how-to's, Release:
reviews, and anything else you want to tell your fellow *buntu users. Friday 26th July 2013.
Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice
please see the OFficial Full Circle Style Guide: http://url.fullcirclemaqgazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org =
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org 7,
Questions for Q&A should go to: questions@Ffullcirclemagazine.org \
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

Full Circle Team

(”\
Editor - Ronnie Tucker -/
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org

Podcast - Les Pounder & Co.
podcast@°fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

J

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with

the epub file, you can drop an email to: mobile@Ffullcirclemagazine.org

Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and

you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to

spread the word about FCM and Ubuntu Linux.

Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button

ﬁ circle', choose an issue, and click the download button.
o)

which is available on issues 51+.
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